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INTRODUCTION

INTRODUCTION

This document explains how to manage color output on the TOSHIBA GA-1310

and provides information about calibration and color profiles.

This document is part of a set of documentation that includes documentation for users and

system administrators. For a complete description of your TOSHIBA GA-1310, see the other

manuals available at your site.

For more information about supported operating systems and system requirements, see

Welcome.

Terminology and conventions

This document uses the following terminology and conventions.

Term or convention

Refers to

Aero

GA-1310 (in illustrations and examples)

Command WorkStation

Command WorkStation, Windows Edition and
Command WorkStation, Macintosh Edition

Copier

e-STUDIO 5520C/6520C/6530C

GA-1310

TOSHIBA GA-1310

Mac OS

Apple Mac OS X

Titles in 7talics

Other books in this documentation set

Windows

Microsoft Windows 2000, Windows XP, Windows
Server 2003, Windows Vista

Topics for which additional information
is available by starting Help in the software

Tips and information

Important information

Important information about issues that can result
in physical harm to you or others




INTRODUCTION

About this document

This document is organized to supply you with key information about managing the color
output of your GA-1310.

This document covers the following topics:
* Installing and configuring ColorWise Pro Tools.
* Using Color Editor, Profile Manager, and Color Setup.

* Opverview of calibration and description of how to calibrate the GA-1310 using various
ColorWise Pro Tools Calibrator methods.

*  Using Spot-On to manage spot colors.
* Setting ColorWise print options from Windows and Mac OS computers

* Descriptions of Simple ASCII File Format (SAIFF), which can be used to import toner
density measurements from measurement devices.

Note: The Glossary defines words in bold, for example, output profile, that appear
throughout this manual. Color terms and concepts, such as “color space,” “spot color,”
“gamut,” and “source profile,” are used throughout this manual. If you are new to desktop
color, or if any terms are unfamiliar, see the Glossary.
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Key features of ColorWise

ColorWise is the color management system (CMS) built into the GA-1310 and designed to
provide both casual and expert users with the best color output for a variety of purposes. The
ColorWise default settings provide high-quality, out-of-box color from many Windows and
Mac OS applications. This allows casual users to achieve quality output without knowing
about or changing any color settings on the GA-1310.

For consistent color, calibrate the GA-1310 on a regular basis. ColorWise Pro Tools includes
an easy-to-use calibrator, which allows you to calibrate using either the scanning unit that is
part of the copier or an optional spectrophotometer or densitometer (see “Calibration” on

page 32).

ColorWise features allow you to modify printing results. Depending on your particular needs,
you can:

*  Set the behavior of CMYK printing to emulate DIC, Euroscale, SWOP, and other offset
press standards.

*  Match PANTONE and other spot colors for the best match when printing using
four-color press conditions or presses with extra, custom plates.

*  Select a color rendering dictionary (CRD), also called a rendering style, for RGB printing.
CRDs allow for rich, saturated printing of presentation graphics, smooth, accurate
printing of photographs, and relative or absolute colorimetric rendering for specialized
needs.

* Define the source of incoming RGB color data for better color conversion of RGB data
with no source information.

* Determine whether RGB data is converted into the full gamut of the copier or is first
converted into the gamut of another device, such as a press standard. This feature is useful
for making one device behave like another for RGB data. It also allows you to evaluate the
appearance of an RGB file under different printing conditions without having to convert

the RGB file to CMYK first.

ColorWise color management (ColorWise) offers an open color architecture, allowing

users to customize the GA-1310 to meet new printing needs as they arise. ColorWise supports
ICC profiles, which are industry standard color profiles that describe the color behavior of a
device. Note that ICC specification version 4 profiles (profile version 4.2.0.0) are supported
as well as version 2. Downloading ICC profiles to the GA-1310 enables the GA-1310 to
simulate a custom press (or another copier), as well as accurately print colors from a particular
monitor or scanner. In addition, you can create customized ICC profiles for the copier.

ColorWise also allows you to use any Status T densitometer by importing data in a standard
file format (see “Importing Density Measurements” on page 101). In this case, it is important
to note that the quality of the instrument used determines the quality of the calibration.
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CoLORWISE Pro TooLS

The ColorWise default settings provide high-quality out-of-box color from many Windows
and Mac OS applications. This allows casual users to achieve quality output without knowing
about or changing color settings on the GA-1310. The ColorWise color management system
(CMS) also allows expert users to obtain the best color output. ColorWise Pro Tools allows
users to customize settings to achieve the best output for a variety of purposes.

Designed to give flexible control of color printing, ColorWise Pro Tools includes the
following color management tools:

* Calibrator (calibrate the GA-1310 in various ways)

* Color Editor (customize simulation and output profiles)

* Profile Manager (manage profiles)

e Spot-On (define CMYK equivalents for spot colors)
Spot-On is offered as an option.

* Color Setup (set defaults for ColorWise print options)

About this chapter

This chapter describes the procedures for installing, configuring, and using ColorWise Pro
Tools on Windows and Mac OS computers.

Platform To do this See

Windows Install ColorWise Pro Tools page 11
Install the ICC profiles page 11
Configure the connection page 13
Modify the configuration page 14

Mac OS Install ColorWise Pro Tools page 15
Install the ColorSync profiles page 15
Configure the connection page 17

Modify the configuration page 18
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Platform To do this See

Windows and Mac OS Use Calibrator page 19
Use Color Editor page 19
Use Profile Manager page 24
Use Spot-On page 29
Use Color Setup page 30

Setting up ColorWise Pro Tools on a Windows computer

The following sections describe how to install ColorWise Pro Tools and other files and
configure the connection on a Windows computer.

Installing ColorWise Pro Tools

All installation of user software on a Windows computer is done through the Fiery User
Software Installer. The procedures in Utilities describe installing from the User Software
DVD.

To run ColorWise Pro Tools on a Windows computer, you must have Sun Java 5 or 6
installed on the computer. If this file is not installed on your computer, the ColorWise Pro
Tools installer automatically initiates the installation process. Follow the on-screen

instructions.

Installing the ICC profiles

You can copy additional ICC profiles from the User Software DVD to your computer. Use
the ICC profiles with applications that support ICC standards, such as Adobe Photoshop. For
most ICC-aware applications, you must install the files in a folder named Color. For use with
ColorWise Pro Tools, copy the files to a folder of your choice.

To INSTALL THE ICC PROFILES ON A WINDOWS COMPUTER FROM THE USER SOFTWARE DVD
1 Insert the User Software DVD into the DVD drive.

2 Open the ICC folder.
3 Right-click the profile that you want, and then click Install Profile.

The profiles are installed automatically to the Windows\System32\spool\drivers\color folder
(Windows XP/Server 2003/Vista) or WINNT\System32\spool\drivers\color folder
(Windows 2000) on your computer.
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Color files

You can copy additional color files from the User Software DVD. Many of the files are
PostScript files that you can import and print using Command WorkStation.

Windows Color
Files folder

Color Bars folder
(inside the Windows
Color Files folder)

PS Files folder
(inside the Windows
Color
Files\Calibration
Files folder)

Halftone Calibration
Files folder

(inside the Windows
Color
Files\Calibration
Files folder)

CMYK Color Reference.ps: An 11-page, Letter-size PostScript file
used for reference when defining CMYK colors in applications.

PANTONE Book.ps: A 20-page, Letter-size PostScript file that
indicates the closest equivalent of PANTONE coated colors that
the GA-1310 and your copier model can produce. The method
used to print the PANTONE Book.ps file differs depending on
the Spot Color Matching setting. For more information, see
“Spot Color Matching” on page 93.

RGB page 01.doc: A Microsoft Word file you can print to view
available RGB colors.

RGB page 02.ppt: A Microsoft PowerPoint file you can print to
view available RGB colors.

FieryColorBar.eps: Can be used to print a color control bar.

Custom21.ps, Custom34.ps, Standard21.ps, and Standard34.ps:
PostScript files of color patches for obtaining measurements.

The numbers in the file names refer to the number of patches on
the page. The Custom files allow you to download measurement
patches that incorporate the current calibration set of the copier.
The Standard files allow you to download standard measurement
patches that bypass the current calibration set of the copier.

NoTEe: These files are provided for expert users and should not be
used for day-to-day calibration.

Images of measurement pages for various calibration instruments
and page sizes, used for calibrating the GA-1310 for different

halftone screens. Files are provided for Adobe Photoshop and for
other applications.

NoTE: For the X-Rite DTP32 Series II densitometer, use the
calibration file for the X-Rite DTP32 densitometer.

NoTe: Files for the ED-100 densitometer are provided. However,

the ED-100 is not a supported measurement device.
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Configuring the connection

The first time you start ColorWise Pro Tools, you must configure the connection to the
GA-1310.

BEFORE YOU BEGIN
¢ Print the Configuration page and note the IP address of the GA-1310.

For instructions on printing the Configuration page, see Configuration and Setup.

This page contains information you need when configuring the connection, such as the IP
address. For TCP/IP installations, you can use the Domain Name Server (DNS) name of the
GA-1310 instead of the IP address. Make sure the GA-1310 is listed in a DNS used by your
network. For more information, see the documentation that accompanies your Windows
system.

TO CONFIGURE THE CONNECTION FOR COLORWISE PRO TOOLS
1 Start ColorWise Pro Tools.

2 If the Choose Printer Device dialog box appears, click Add.
3 Enter the appropriate information for the GA-1310.

Nickname: Type a name for the GA-1310. This name does not have to match the actual Server
Name of the GA-1310.

NoTE: The nickname cannot contain a Tab character.
Server Name or Server IP address: Type the IP address (or DNS name) of the GA-1310.

New Device: Type a device name for the GA-1310. This name does not have to match the
device name of the GA-1310.

Add Server x|

Micknanme ||

"SEI’VEI’ name or Server IP address:

New Device

| fd

Dievic

Remove |

Lalie Cancel |

4 When you have typed all the information, click Add.
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With the device name selected in the Devices list, click OK.

The GA-1310 appears in the list of Available Servers. The first line of the entry displays the
nickname you assigned the GA-1310, followed by the protocol. The second line displays the
device name.

Choose Printer Device =
Available Servers
E-Aero TCPAP] ﬂ
B = device name:s

Remave |
iy |

ul

Select | Cancel |

With the device name selected in the list of Available Servers, click Select.
If you are prompted for the server password, type the password and click Login.

The ColorWise Pro Tools main window appears.

Editing the configuration

Edit the configuration whenever a change to your GA-1310 or network occurs, such as a
server name or IP address change. Change the specific GA-1310 Setup information before

you configure the connection.

To EDIT THE CONFIGURATION

1
2

Start ColorWise Pro Tools to open the Choose Printer Device dialog box.

To add a new GA-1310, click Add. Configure the Add New Server dialog box as outlined in
steps 3 through 5 in the previous procedure.

To remove a GA-1310, select the GA-1310 by its nickname and click Remove.

To modify information, select the GA-1310 by its nickname and click Modify. Edit the
information in the Modify Server Settings dialog box and click OK.

The list of Available Servers reflects your modifications.
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Setting up ColorWise Pro Tools on a Mac 0S computer

The following sections describe how to install ColorWise Pro Tools and other files and
configure the connection on a Mac OS computer.

Installing ColorWise Pro Tools on a Mac 0S computer
You can install ColorWise Pro Tools from the User Software DVD.

Before you begin each installation, determine where you want to install each item on your
hard disk. Otherwise, the software is placed in the “Fiery” folder by default.

To INSTALL COLORWISE PRO TOOLS ON A MAC OS COMPUTER FROM THE USER SOFTWARE DVD
1 Insert the User Software DVD into the DVD drive.

2 Browse to the folder for your operating system.
3 Double-click the ColorWise Pro Tools installer icon.
4 Follow the on-screen instructions.

5 If prompted, click Quit to close the installer.

Installing the ColorSync profiles

You can copy additional color files from the User Software DVD. Use the ICC profiles with
applications that support ICC standards, such as Photoshop. For most ICC-aware
applications, you must install the files in a folder named Profiles in the Library: ColorSync
folder. For use with ColorWise Pro Tools, you can copy the files to a folder of your choice.

To INSTALL THE COLORSYNC PROFILES ON A MAC OS COMPUTER FROM THE USER SOFTWARE DVD
1 Insert the User Software DVD into the CD-ROM drive.

2 Open the ColorSync folder.
3 Copy the profiles into Library: ColorSync: Profiles.
NoTe: You must be logged in as an administrator.

After you install the ColorSync files, see the ColorSync documentation for setting ColorSync

profiles, such as EFIRGB.
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Color files

You can copy additional color files from the User Software DVD. Many of the files are

PostScript files that you can import and print using Command WorkStation.

Mac Color
Files folder

Color Bars folder
(inside the Mac
Color Files folder)

PS Files folder
(inside the Mac
Color Files:
Calibration Files

folder)

Halftone Calibration
Files folder

(inside the Mac
Color Files:
Calibration Files
folder)

CMYK Color Reference.ps: An 11-page, Letter-size PostScript file to
use for reference when defining CMYK colors in applications.

PANTONE Book.ps: A 20-page, Letter-size PostScript file that indicates
the closest equivalent of PANTONE coated colors that the GA-1310
and your particular copier model can produce. The method used to
print the PANTONE Book.ps file differs depending on the Spot
Color Matching setting. For more information, see “Spot Color
Matching” on page 93.

RGB page 01.doc: A Microsoft Word file you can print to view
available RGB colors.

RGB page 02.ppt: A Microsoft PowerPoint file you can print to view
available RGB colors.

FieryColorBar.eps: Can be used to print a color control bar.

Custom21.ps, Custom34.ps, Standard21.ps, and Standard34.ps:
PostScript files of color patches for obtaining measurements.

The numbers in the file names refer to the number of patches on the
page. The Custom files allow you to download measurement patches
that incorporate the currently installed calibration set. The Standard
files allow you to download standard measurement patches that
bypass the currently installed calibration set.

NoTE: These files are provided for expert users and should not be
used for day-to-day calibration.

Images of measurement pages for various calibration instruments and
page sizes, used for calibrating the GA-1310 for different halftone
screens. Files are provided for Adobe Photoshop and for other
applications.

NoTE: For the X-Rite DTP32 Series II densitometer, use the
calibration file for the X-Rite DTP32 densitometer.

NoTe: Files for the ED-100 densitometer are provided. However, the

ED-100 is not a supported measurement device.
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Configuring the connection

The first time you start ColorWise Pro Tools, you must configure the connection to the
GA-1310.

NoTe: ColorWise Pro Tools is supported only over TCP/IP networks.

BEFORE YOU BEGIN
¢ Print the Configuration page and note the IP address of the GA-1310.

For instructions on printing the Configuration page, see Configuration and Setup.

This page contains information you need when you configure the connection. For TCP/IP
installations, you can use the Domain Name Server (DNS) name of the GA-1310 instead of
the IP address. Make sure the GA-1310 is listed in a DNS used by your network. For more
information, see the documentation that accompanies your Macintosh system.

TO CONFIGURE THE CONNECTION FOR COLORWISE PRO ToOLS

1 Double-click the ColorWise Pro Tools icon.

The Choose Printer Device dialog box appears.

800 Choose Printer Device

Available Servers

Add...

( Remove )

‘\L Medify )

e

2 If the No Servers Configured dialog box appears, click OK. If the Choose Printer Device dialog
box appears, click Add.

800 Add Server

Nickname [ ]

"Server name or Server IP address:—————————————

New Device

[ | (add )

Devices

Remove
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Enter the appropriate information for the GA-1310.

Nickname: Type a name for the GA-1310. It does not have to match the actual server name of
the GA-1310.

NoTE: The nickname cannot contain a Tab character.

Server name or Server IP address: Type the IP address (or DNS or host name) of the
GA-1310.

New Device: Type a device name for the GA-1310. This name does not have to match the
device name of the GA-1310.

When you have typed all the information, click Add.
With the device name selected in the Devices list, click OK.

The GA-1310 appears in the list of Available Servers. The first line of the entry displays the
nickname you assigned the GA-1310, followed by the protocol. The second line displays the
device name.

800 Choose Printer Device
Available Servers

¥ Aero [TCP/IF] dd
<device name>

Remove

1k
= E

With the device name selected in the list of Available Servers, click Select.

The ColorWise Pro Tools main window appears.

Editing the configuration

Edit the configuration whenever a change to your GA-1310 or network occurs, such as a
server name or [P address change. Change the specific GA-1310 Setup information before
you configure the connection.

To EDIT THE CONFIGURATION

1
2

Start ColorWise Pro Tools to open the Choose Printer Device dialog box.

To add a new GA-1310, click Add. Configure the Add Server dialog box as outlined in steps 3
through 5 in the previous procedure.

To remove a GA-1310, select the GA-1310 by its nickname and click Remove.

To modify information, select the GA-1310 by its nickname and click Modify. Edit information
in the Modify Server Settings dialog box and click OK.

The list of Available Servers reflects your modifications.
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Using ColorWise Pro Tools

ColorWise Pro Tools gives you flexible control of color printing by allowing you to calibrate
the GA-1310, customize simulation and output profiles, manage profiles on the GA-1310,
manage spot colors, and set default values for ColorWise print options.

Using Calibrator

ColorWise Pro Tools Calibrator allows you to calibrate the GA-1310 using one of a number
of measurement methods. For information about calibrating the GA-1310, see page 32.

Using Color Editor

ColorWise Pro Tools Color Editor allows you to create custom profiles by editing existing
simulation or output profiles, and then saving the changes as a new profile. Use Color Editor
to fine-tune a profile on the GA-1310 to meet your exact specifications. Access Color Editor
directly, by clicking its icon in the ColorWise Pro Tools main window, or indirectly, through
the Profile Manager.

NoTEe: You cannot edit source profiles. Only simulation and output profiles can be

customized.

To use COLOR EDITOR
1 Start ColorWise Pro Tools and connect to the GA-1310.

EE ColorWise Pro Tools
File Tools Help

Lero_=device names=

%

Calibrator Color Editor | Profile Manager 2 Colar Setup
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2 Click Color Editor.

=
Description | wndifet |
DIC (EFD DBINGING B 3756 A

D20308 1:37:49 AM
0.0 L]
020308 0:22:41 PM

Euroscale (EF[)

el

150 Uncoated

MPAver.2 (EFD) 02702708 10:44:39 AM

apan Color 2001 typet (EFN) 080308 12:45:43 PM
SWOP-Coated (EFI) 0808708 8:37:56 AM
[TOv0 Offset Coated 2.0 020808 5:37 56 A

Description: |ISOCuated Select I
Wiew: ISimuIatiUn ;I Cancel |

Simulation lists the simulation profiles resident on the GA-1310. Output lists the output
profiles resident on the GA-1310.

3 Select a profile and click Select.

3 color Editor:5WOP-Coated (EFD) |_ (O] x
Edit hode
— [Master ~
2
g Cyan
. O=
B
hiagenta
R &
o
2
e llow
8 E
o
2
I~ Black
° B
o
= N
=
% - Brightness = +
o o "
0 10 20 30 40 50 60 7O 80 90 100 Dot Gain.. |
InpUE %

I_MDIL I_Ol"tim_ A | Remave

Curves I

Test Print... | Import.. | Select Profile... | Save.. | Done: |

For more information about Color Editor, see the Color Editor section of ColorWise Pro
Tools Help.



CoLORWISE PRro TooLS

Adjusting gray balance

The AutoGray feature allows you to use the copier’s built-in scanner as a measurement device
for adjusting the gray balance of output profiles. Gray balance refers to the quality of neutral
gray tones in a profile. In many cases, gray tones may contain a bluish or reddish color cast.
AutoGray helps shift these tones back toward neutral grays. If you are satisfied with the gray

balance of the copier, you do not need to use AutoGray.

TO CORRECT THE GRAY BALANCE OF AN OUTPUT PROFILE
1 Start ColorWise Pro Tools and click Color Editor.

2 Choose Output from the View list.

3 Select a profile to edit and click Select.

Or, you can open the Profile Manager, select a profile, and then click Edit, which starts Color

Editor.

Edit Mode:
— [Custom

10 20 30 40 50 60 70 &0 90 100

Qutput %

o

0
Input %

10 20 30

E Color Editor: [Profile name]

=10l x|

40 50 B0 7O B30 90 100

Cyan Dl ax

Magenta D-hiax

e llow Db ax

Black Db ax

EBrightness - I +
Dok Gain. ..
AuboGray...

Input

Cutput

I— l_ l— I— Add | Remave

| Curves

Tesk Print... |

Impart... | Select Profile... |

Save... | Done

4 Choose Custom from the Edit Mode menu.

5 Click AutoGray.
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6 If the output profile contains no edit points, continue to step 8. If the output profile
contains edit points from a previous AutoGray session, choose Refine or New.

- AutoGray Points E

4 -\

This profile already contains AutoGray edit points.

"Refine” will recycle current edit paints
for more accurate gray halance.

"Mew” will rermove current edit points
and proceed with new edit points.

CRefine e | Cancel |

Refine reuses edits points from a previous session in an attempt to make them more accurate.
Refine is optional; use it only if the gray balance in your test document still needs
improvements after the first AutoGray session. If two Refine applications cannot fix the
situation, it is probably because your test document is not correctly addressing the output
profile, or because the output profile that you are editing does not adequately describe the
actual copier and printing conditions. Applying Refine more than twice is not recommended.

New starts a new AutoGray session by first removing all edit points from a previous session.
New is recommended when you have performed more than two Refine applications.

7 If the output profile contains edit points that were entered by a user, choose Proceed to
remove the points and continue with the AutoGray adjustment.

Proceed starts a fresh AutoGray session by first removing all user edit points. This is because
AutoGray cannot modify user-entered points.

This profile contains user-defined edit points.

FProceeding with AutoGray will remave
all current edit paints.

Cancel |
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In the Print Options dialog box that appears, choose the Input Tray to use for the
measurement page and click Print.

Print Options x|

Page Type

IAutoGray Measurement Page LI

Paper Size
JLTRy84 |

Inpuk Tray

Auto Select

Mumber of copies: Il 3:

cos |

The Page Type is automatically set to AutoGray Measurement Page.
The Paper Size is automatically set to LTR/A4.
Retrieve the measurement page from the copier.

Follow the directions in the dialog box for placing the grayscale strip and the AutoGray
measurement page on the copier glass, and click Continue.

Messages display the progress of the gray balance adjustment.
When the adjustment is complete, click OK.

Color Editor displays the adjusted output profile curve. New edit points have been inserted by
AutoGray to modify the gray balance, in much the same way an expert user would have done
manually.

To make edits to the output profile curve, click AutoGray again.

Choose Refine to fine-tune the curve, or New to acquire a new curve for editing.
For more information about these steps, see page 22.

To accept the AutoGray adjustment and save the results as a new profile, click Save.

Click Done to close Color Editor.
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Using Profile Manager

ColorWise Pro Tools Profile Manager allows you to manage and edit ICC profiles.

To USE PROFILE MANAGER

1 Start ColorWise Pro Tools and connect to the GA-1310.

EE ColorWise Pro Tools
File Tools Help

Lero_=device names=

Calibratar Color Editor

Profile Manager

Colar Setup

2 Click Profile Manager.

The Profile Manager window appears.

[E2 Profile Manager: Aera

i IC WWINNTIsystem32ispooldriversiCalar LI

Delete

Cescription

Generic Monitor Adobe1938RGE DES WP 2.2 Gamma =l
Generic Monitar AppleRGE DES WP 1.8 Gamma
DiamandTron Monitor 322 D93

Genetic Monitor D33 WP 1.8 Gamma

8 | Description:

Edit: Prafile Setiings

Appear in Driver ..

8 Apple Standard
8 sRGB(FC)
8 Adobe RGE (1938)

P

Apple Standard ﬂ
SRGE
Atobe RGE =

Genetic Monitor D33 WP 2.2 Gamma
Hitachi Monitor G22 D33

MNEC MultiSync Gamma 1.9 Monitor
MNEC MultiSync Gamma 1.8 Monitor
MNEC MultiSync Gamma 2.2 Monitor

8 DIC (EFD
8 Euroscale (EFI)
8 IS0 Coated

I\ & | Description Appear in Driver

DIC ﬁl
Euroscale
150 Coated =l

Genetic EBU 1.5 Gamma Monitor
Genetic EBU 1.8 Gamma Monitor
Genetic EBU 2.2 Gamma Monitor
Genetic P22 1.5 Gamma Maonitor
Genetic P22 1.8 Gamma Monitor
Genetic P22 2.2 Gamma Maonitor
MNEC Multisyne Monitor G22 D33

dia Defined Profile

Output

Appearin Driver a..

8 | Description:
1 & =profile name=

Genetic Monitor NTSC llluminant WP 2.2 Gamma -

4| | » 8| Description: Source Output
I\ DevicelinkProfileicc

wiew: [Description =

Filename Creation Date

Description Last Modified Done

Device Class

Copyright

3 Click any profile to select it.

Information about the profile, such as its creation date and ICC specification version, appears
at the bottom of the window. Note that ICC specification version 4 profiles (profile version
4.2.0.0) are supported, as well as version 2.

For more information about Profile Manager, see the Profile Manager section of ColorWise

Pro Tools Help.

-

%

For information about the Use Media Defined Profile option, see “Using media-defined
output profiles” on page 25.

For more information about using Device Link Profiles, see page 25.
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Setting the default profiles

Use Profile Manager to set a default RGB source profile, simulation profile, or output profile.
The default RGB source and simulation profiles that you set are applied to all print jobs sent
to the GA-1310, unless you override them using print options. The same is true of the default
output profile that you set, unless you select the Use Media Defined Profile option.

The Use Media Defined Profile option indicates whether or not to automatically apply the
output profile associated with the media type used in a print job. For more information, see
the following section.

Using media-defined output profiles

Instead of having Profile Manager apply a default output profile to all your print jobs, you can
keep the Use Media Defined Profile option selected. This option automatically applies the
output profile predefined for the media type in your print job. If your job contains mixed
media, this option can apply different output profiles predefined for the different media.

To USE MEDIA-DEFINED OUTPUT PROFILES

1 Start ColorWise Pro Tools and click Profile Manager.
2 Select Use Media Defined Profile in the Output bar of Profile Manager.

Changing the setting for the Use Media Defined Profile option in Profile Manager
automatically changes the same setting in Color Setup. For more information, see
“Using Color Setup” on page 30.

About Device Link Profiles
The GA-1310 supports the use of Device Link Profiles. A Device Link Profile describes the

conversion from one color space to another. Device Link Profiles are restrictive because they
define the complete conversion from a source device to a destination device. When you print
using a Device Link Profile, you do not choose a source profile or an output profile because
the Device Link Profile specifies both. ColorWise supports two kinds of Device Link Profiles:
RGB source to CMYK destination and CMYK source to CMYK destination.

A Device Link Profile bypasses most ColorWise color management because the information
needed to convert from the source to destination is fully contained in a Device Link Profile.

To create a Device Link Profile, use profile-generating software such as EFI Color Profiler
Suite.

NoTE: Depending on your job’s workflow, you may not need to use Device Link Profiles.
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Installing Device Link Profiles

If you are an administrator, you can download Device Link Profiles to the GA-1310 using
Profile Manager. You must associate a Device Link Profile with the following settings:

* An RGB Source Profile or a CMYK Simulation Profile setting and

* An Output Profile setting
The Device Link Profile is enabled when these two settings are selected.

You can enable a Device Link Profile in three locations:

* In ColorWise Pro Tools Color Setup, select the default settings for RGB Source Profile,
CMYK Simulation Profile, and Output Profile. These settings apply to all jobs unless
overridden for a particular job.

*  Use Expert Color Settings in the GA-1310 printer drivers to select the settings for RGB
Source Profile, CMYK Simulation Profile, and Output Profile when you print a job.

* Use Command WorkStation Job Properties to override the settings for RGB Source
Profile, CMYK Simulation Profile, and Output Profile for a specific job.

For more information about enabling Device Link Profiles using Color Setup, see page 31.
For more information about enabling Device Link Profiles using Expert Color Settings in the
GA-1310 printer driver see page 99.
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To DOWNLOAD DEVICE LINK PROFILES USING PROFILE MANAGER

1 In Profile Manager, if you do not see the Device Link Profile in the Description list, select the
folder that contains the Device Link Profile by clicking Browse in the upper-left corner.

2 Click OK to add the folder contents to the Description list.
The Device Link Profile is added to the Description list.

3 To add the Device Link Profile to the Device Link panel, select the Device Link Profile in the
Description list and click the green arrow pointing to the Device Link panel.

1 Device Link Panel ERProfile Manager: Aera P EX

Delet Edit Prafile Beti
IC WWINNTIsystem32ispooldriversiCalar LI Set L [l oslings

D I
GEL mﬂ_ 8 | Description: Appeat in Driver ...

Generic Monitor Adobe1938RGE DES WP 2.2 Gamma =l

) 8 Apple Standard Apple Standard B
Generic Monitar AppleRGE DES WP 1.8 Gamma 8 sROE FO) SRGB
DiamandTron Monitor 322 D93

y — 8 Adobe RGE (1938) Adobe RGB j
Genetic Monitor D33 WP 1.8 Gamma
Genetic Monitor D33 WP 2.2 Gamma
Hitachi Manitor 522 D33 & | Description Appear in Driver
MNEC MultiSync Gamma 1.9 Monitor I\ & DIC EFD DIC ﬁ!
MNEC MultiSync Gamma 1.8 Monitor & Euroscale (EFI) Euroscale
MNEC MultiSync Gamma 2.2 Monitor 8 IS0 Coated 150 Coated LI
Genetic EBU 1.5 Gamma Monitor = =
Gereric EBU 1.8 Gamma Monitar [ Use Media Defined Profile Output
Generic EBU 2.2 Gamma Manitar 8 | Description: Appear in Driver a..
Generic P22 1.8 Gamma Monitor I\ & =profile name=
Genetic P22 1.8 Gamma Monitor ||
Genetic P22 2.2 Gamma Maonitor —

MNEC Multisyne Monitor G22 D33

Genetic Monitor NTSC llluminant WP 2.2 Gamma -

4| » 8| Description: Source Output
DevicelinkProfileicc

Wiew: IDEsmptmn =

Filename: Creation Date

Description Last Madified B
Device Class

Copyright

The Device Link Profile Settings dialog box appears. To assign settings, see the following
procedure.

Device Link Profile Sel H

Profile Description

IDeviceLinkProFiIe e

If the RGE Source Profile or the Output Profile is left
"Unaszsigned", this Device Link cannot be used.

RGE Source Profile : IUnassigned LI

Cutput Profile : IUnassigned LI

Ok | Cancel | Apply |
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Assigning Device Link Profile settings

The following Device Link Profile Settings dialog box images depict an RGB Source profile
description. If you use a CMYK Simulation profile, the screen will reflect a CMYK
Simulation profile description instead of an RGB Source profile description.

To ASSIGN DEVICE LINK PROFILE SETTINGS

1 After you download the Device Link Profile using Profile Manager and add it to the Device
Link Profile panel, select the source and output profiles for this Device Link Profile in the
Device Link Profile Settings dialog box.

If the Device Link Profile already has a source and output referenced, the Output and Source
Profiles automatically appear.

If the source or output profile referenced in the Device Link Profile is not found on the
GA-1310, the source profile will show “Unassigned” and a message appears, stating that the
source or output profile cannot be found.

Device Link Profile Settings E

Profile Description

IDeviceLinkProFiIe e

If the RGE Source Profile or the Output Profile is left
"Unaszsigned", this Device Link cannot be used.

RGE Source Profile : Unazsigned LI

There is a referenced RGE Source Profile, but it cannot bhe

found.
Information |

Cutput Profile : Unazsigned LI

There is a referenced Cutput Profile, but it cannot be found.
Information |

Ok | Cancel | Apply |

Click Information to find out more about the missing profile.

If you install the source or output profile to the GA-1310 that matches the missing profile
referenced in the Device Link Profile, the “Unassigned” setting is automatically updated.

NoTE: If the source or output setting is unassigned, the Device Link Profile cannot be used.
You must assign settings.
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2 If the Device Link Profile does not have a source or output assigned, select a Profile
Description name, and the source and output profiles for the Device Link Profile.

Device Link Profile Settings E

Profile Description

IDeviceLinkProFiIe e

If the RGE Source Profile or the Output Profile is left
"Unaszsigned", this Device Link cannot be used.

RGE Source Profile : IUnassigned LI
Cutput Profile : IUnassigned LI
Ok | Cancel | Apply |

3 When you are finished assigning settings to the Device Link Profile, click OK.

Modifying Device Link Profiles

To modify the Device Link Profile settings, use the following procedure.

To MODIFY DEVICE LINK PROFILE SETTINGS
1 Double-click the Device Link Profile in the Device Link panel.
The Device Link Profiles Settings dialog box appears.
2 Enter the new Source and Output profiles.

3 Click Apply and then click OK.

NoTE: You cannot edit the Device Link Profile in ColorWise Pro Tools. You must use the
application that was used to create the Device Link Profile.

Using Spot-On

Spot-On allows you to adjust and manage lists of spot colors and their CMYK equivalents.
The matching lists of spot colors and CMYK values are known as Spot Color Dictionaries.
Spot-On allows you to maintain multiple Spot Color Dictionaries for each output profile on
the GA-1310. For more information about Spot-On, see page 56.
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Using Color Setup

ColorWise Pro Tools Color Setup allows you to set the default values for the ColorWise print
options and print settings for the GA-1310.

These settings are applied to all print jobs sent to the GA-1310, unless a user overrides them
for an individual job by changing settings in the printer driver. These default settings can also
be overridden using Command WorkStation. In addition, the defaults set in Color Setup are
automatically reflected in other GA-1310 tools that list default settings.

The options in Color Setup are arranged in a pattern representing the flow of color processing
that takes place on the GA-1310. To reset the GA-1310 to its factory default settings, click
Factory Default in the lower-left corner of the Color Setup window.

To use COLOR SETUP
1 Start ColorWise Pro Tools and connect to the GA-1310.

" ColorWise Pro Tools
File Tools Help

Aero_=device names=

S,

Calibrator Color Editar Frofile Manager Color Setup

2 Click Color Setup.

[l Color Setup I =]
These optians will be used as the default far this printer.

e |

ReE Source Profile: Rendering Style:
a
g -, — [EFIRGE | s [Pras=rtation =
Print Gray using Black Only (REE): [
off =| © Simulation & Output
]
CMYK Simulation Profile: MV Simlation Method:
% = e 150 Coated | . [Full (Ot GCR) 7| —
& Print Gray using Black Only (CM7K): Output Profile:
[TestiGraphics/images = Use Media Defined Profile -~
Ed
g et [1# St Color Matching
&
Black TextjGraphics |
5
E] sy [P Black O -
=
Black Owerprint: J
[Text/Graphics =
Factory Defaults Ay

oK Cancel
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Using Color Setup to enable Device Link Profiles

You can enable Device Link Profiles using Color Setup.

For information about installing and assigning Device Link Profiles, see page 26.

To use COLORWISE COLOR SETUP TO ENABLE DEVICE LINK PROFILES
1 Open Color Setup from ColorWise Pro Tools.

2 Select the RGB Source profile or the CMYK Simulation Profile and the Output Profile.

When you select a source and output combination that is defined as a Device Link Profile, the
Device Link Profile is automatically activated.

When the Device Link Profile is selected, the Color Process workflow updates and some of
the Fiery print options may not appear.

You will see the message “Device Link Profile in use” under the RGB Source Profile or
CMYK Simulation Profile.

1 Device Link Profile in use JE

These options will be used as the default for this printer.

e |

RiGE Source Profile:

1o, | ==t [ficbe D (1955) -
- @ewce Link Profile in Use : =devics link profile nam =
Prink Gray Using Black Gy (RGE)

RGE

oFf -
CMYK Simulation Profile: CMVK Simulation Method:

% e [150 Coated | e [Ful (Ot GERY | —

Y& Frint Gray using Black Only (CMYK): Output Profile:
[TestiGraphics/images = b | =rfile name= -~

e [/ Spot Colar Matching

Spot

Black TextiGraphics

[P Black 01 -
Black Overprint: J
[TextfGraphics =

Black.

Factory Defaults Apply

oK Caneel

3 Click OK to exit Color Setup.
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CALIBRATION

Calibrating the GA-1310 ensures consistent and reliable color output. Calibrate the GA-1310
using ColorWise Pro Tools Calibrator with the copier’s built-in scanner, a densitometer or a
spectrophotometer.

NoTEe: You can disable calibration (and color management) for CMYK data in a job by using
the ColorWise Off setting for the CMYK Simulation Profile option. For more information,
see “CMYK Simulation Profile” on page 85, You might want to disable calibration for testing
purposes, for example.

This manual uses the following terminology for color measurement instruments:

Term Refers to

ColorCal with Calibrator Calibration method that uses the copier’s built-in scanner to measure
toner density values. You can use Calibrator in ColorWise Pro Tools to
petform ColorCal calibration.

DTP32 or DTP32 Series I  X-Rite DTP32 or DTP32 Series II automatic densitometer

DTP41 X-Rite DTP41 automatic spectrophotometer

ES-1000 Spectrophotometer ES-1000 hand-held spectrophotometer
ColorCal from the copier Calibration method that uses the copier’s built-in scanner to measure
touch panel toner density values. You can use the copier touch panel to perform

ColorCal calibration.
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About this chapter

This chapter describes the procedures for calibrating the GA-1310 using ColorWise Pro Tools
Calibrator with various color measurement instruments or calibrating from the copier touch
panel. The following table provides the location of each procedure.

Calibration method See

ColorCal with Calibrator page 38
DTP32 or DTP32 Series II with Calibrator page 42
DTP41 with Calibrator page 44
ES-1000 with Calibrator page 47
ColorCal from the copier touch panel page 50

This chapter also describes important concepts and suggestions for understanding calibration.
The following table provides the location of each description.

For more information about See

An overview of calibration page 52
How calibration works page 53
Scheduling calibration page 54
Checking calibration status page 55

NoTe: The procedures described in this chapter are fundamentally the same for Windows and
Mac OS computers. llustrations from a Windows computer are used in this chapter.
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Calibrating with ColorWise Pro Tools Calibrator

ColorWise Pro Tools Calibrator allows you to calibrate the GA-1310 using the measurement
method of your choice.

Changing calibration has the potential to affect a// jobs for 4/l users, so consider limiting the
number of people authorized to perform calibration. Set an Administrator password to
control access to calibration (see Configuration and Setup).

NoTe: Multiple users can be connected to one GA-1310 with ColorWise Pro Tools, but only
one user at a time can use Calibrator. If you try to calibrate when another user is using
ColorWise Pro Tools to calibrate, an error message appears.

Starting Calibrator

Start Calibrator from the ColorWise Pro Tools main window.

To CALIBRATE THE GA-1310 USING CALIBRATOR
1 Start ColorWise Pro Tools and connect to the GA-1310.

£B colorwise Pro Tools
File Tools Help

Lero_=device names=

Calibratar Color Editor Profile Manager o Color Setup

For information about conﬁguring the connection to the GA-1310, see pages 13

and 17.
2 Click Calibrator.
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Calibration methods

Calibration methods

CALIBRATION

EEcalibrator- Aero_DeviceName
Standard Expert

1. Select Measurement Method

2. Check Print Settings

o

Calibration Set

RESOLUTION [00DPI

[
[

Media IPIa\n

Measured: 11f10/08 6:59:00 AM
By User: Administrator
Method: ColorCal

Frint... |

Measure... | From File... |

3. Generate Measurement Page
4. Get Measurements

v Applyto all calibration sets Customize... |

3 Choose a method from the Select Measurement Method menu.

Restore Device | Anply | Cone

Procedures for each calibration method are described in subsequent sections of this chapter.

Expert mode

Calibrator provides two modes: Standard and Expert. You can perform all essential
calibration tasks while in Standard mode. Expert mode offers two additional options: Print

Pages and View Measurements.

1. Select Measurement Method

E Calibrator-Aero_DeviceMame

2. Check Print Settings
Calibration Sek

RESOLUTION [snnner

Media IPlain

Measured: 11/10/08 6:53:00 AM
By User: Administrator
IMethod: ColorCal

Standard Expent

3. Generate Measurement Page
Frint. |
4. Get Measurements
FromFilz. |
[comparison Pages | | Print

6. iew Measurements (optional)
IMeasurements Table hd Wiew

Measure I

=1

Customize.

Restore Device |

Save to File | [ sppy | | oone
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CALIBRATION

With the Print Pages option, print Comparison Pages showing the results of the new
measurements with any profile associated with the currently selected calibration set. You can
create a custom Comparison Page and save it as a PostScript or Encapsulated PostScript (EPS)
file called CALIB.PS. Next, print the file to the Hold queue of the GA-1310 from your
application. You can also create a CALIB.PS file by renaming any job in the Hold queue using
Command WorkStation.

With the View Measurements option, you can view the current set of measurements as a table
or graph that shows both the measurements and the target curves.

S Measurements vs. Target [_[O]x

igw Plat Against

— ¥ Measurements ¥ Target <prafle name= -| —

Meaz  Targ

Cyan D-Max_ D-hlax

24 27 30

Magenta D-Max  D-hiax

12 15 18 24

rellow D-Max  D-Max

Dutput Density
00 03 06 04

= Black D-Max  D-Max
0 10 20 30 40 S0 60 7O 80 90 100 B IEE

InpUt %

Target Profile: =profile names= @

| Curves I

Test Prirt... | Inpnrt: | Select Profile. | Save | Done |

When more than one profile uses the same target, an additional menu called Plot Against
appears in the upper-right corner of the dialog box. It lists all output profiles that use that
same calibration set. Selecting an output profile from this menu displays the target curves
associated with that profile. If each output profile contains a unique calibration target, the
curves displayed also change when you switch profiles.
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Applying measurements to multiple calibration sets

Calibrator provides an option (Apply to All Calibration Sets) that allows you to copy the
measurements from the calibration you are currently performing to all calibrations sets on the
server. This option is only available if the GA-1310 has more than one calibration set.

NoTE: For more information about calibration sets, see “An overview of calibration” on
page 52.

If you deselect Apply to All Calibration Sets, you can choose to apply the current calibration
to a selected subset of the calibration sets on the server. You specify which sets by clicking
Customize next to the Apply to All Calibration Sets option, which displays the Apply To

window.
Enpply To 5'
Apply recent measurements to the following other calibration sets
Media
RESOLUTION Plain Plain Paper 1 Plain Paper 2
[V 600DF1 = ~ ¥
[Z 1znnnet [~ ™2 [~
] E— Bl

QK

| Cancel

Click to select or deselect individual calibration sets and then click OK.

If any of the selected calibration sets are not associated with an output profile, you receive a

warning but can choose to apply the calibration measurements to that set anyway.

Warning

‘¥ou have selected one or more calibration sets that are not associated with any output profile,

The calibration measurements are copied to the specified calibration sets at the end of the

calibration process when you click Apply.
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Restoring default calibration measurements

Use the following procedure to return to factory default calibration measurements.

TO RESTORE DEFAULT CALIBRATION MEASUREMENTS

1 In the Calibrator dialog box, click Restore Device.

2 Click OK to restore the preset default calibration set.

& You are about to restore the default calibration For:
Current Calibration Set.

Cancel |

Note: If Apply to All Calibration Sets is selected, all calibration sets on the server are restored.
If Apply to All Calibration Sets is not selected, Restore Device applies only to the calibration
sets selected under Customize.

Calibrating with ColorCal

ColorCal allows you to calibrate the GA-1310 without the use of an additional
spectrophotometer or densitometer. Instead, ColorCal uses the copier’s built-in scanner to

measure toner density values.

ColorCal has the following features:

* Scanner calibration: ColorCal lets you calibrate the scanner (copier feeder) using the Color
Control Patches and grayscale strips.

* Measurement page: For ColorCal, square black-and-white and color patches are randomly
printed on the ColorCal Measurement Page. This allows ColorCal to be less influenced by
copier conditions, providing greater accuracy in color reproduction and calibration.

To calibrate using ColorCal, you will need the grayscale strip included in the customer media
pack that came with your GA-1310. You also need the grayscale strip and Color Control
Patches strip to calibrate the scanner of the copier for ColorCal.

When you run ColorCal from ColorWise Pro Tools, you have the option to calibrate the
copier’s scanner before calibrating the GA-1310 itself. It is recommended to calibrate the
scanner for ColorCal after maintenance or service, or whenever when the copier output has

been altered.
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To CALIBRATE WITH COLOR WISE PRO TooLS AND COLORCAL

1

Start Calibrator.

For instructions on starting Calibrator, see page 34.

In the Select Measurement Method pane, choose ColorCal.

In the Check Print Settings pane, choose an appropriate calibration set.

If more than one option appears, choose the appropriate calibration set for the type of media
you will use most often.

NoTe: For this calibration to take effect, the calibration set must be associated with one or
more output profiles. The default calibration set is already associated with the default output
profile. You do not need to make any new associations except for the Thick2 Paper, Thick3
Paper, or Thick4 Paper calibration sets, which are not associated with any default output
profiles.

Click Print in the Generate Measurement Page pane.

Choose the Page Type.

Print Options El

Page Type

ColorCal Page

Paper Size
|LTRyae |

Inpuk Tray
|Auto Select ~|

MNumber of copies:

[] Print scanner calibration page

* ColorCal Page prints one of the 256 ColorCal patterns chosen at random.

* Single Pattern prints a specific pattern. Enter the pattern number in the Patch Page
Number field.

The Paper Size is automatically set to LTR/A4.
Choose the Input Tray to use for the measurement page.

To print the scanner measurement page and calibrate the scanner before calibrating the
GA-1310, select Print scanner calibration page.

If you clear this option, only the ColorCal measurement page is printed, and the scanner

calibration is skipped.

We recommend that you always calibrate the scanner before calibrating the GA-1310.
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Click Print.
A message appears stating the status of your print job.
Click OK to continue.

Retrieve the ColorCal measurement page (and the scanner measurement page, if you selected
it) from the copier.

Click Measure in the Get Measurements pane.
If you are skipping scanner calibration, go to step 16.

Place the grayscale strip, Color Control Patches strip, and scanner measurement page in the
correct positions on the copier glass for scanner calibration.

Place the grayscale strip face down on the copier glass so that it is centered along the top edge
of the scanner measurement page. Then place the Color Scale strip face down on the copier
glass so it is centered below the grayscale strip, keeping a distance of 0.25 inch to 0.5 inch
between the two strips. Finally, place the scanner measurement page face down over the
strips.

Click Continue to start the scanner measurement.

ColorCal E|

Center the gray scale and Color Contral Patches at the:
top of the scanner calibration page and place on the

H scanner glass,
-_—

““““““ Press 'Continue' to initiate the scan.

[ Continue [ Skip ] [ Cancel ]

When the measurement process completes, the information dialog box appears.

Click Continue to complete scanner calibration.

Information

-
@ Scanner calibrated!
Continue
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Place grayscale strip
face down

Place color measurement
page face down over
grayscale strip
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Place the grayscale strip face down on the copier glass.

Place the strip along the top edge of the copier so that it is centered between the paper width
marks on the copier.

Place the ColorCal measurement page face down over the grayscale strip.
Make sure that the patches on the grayscale strip do not overlap the color patches.

Close the platen glass cover, being careful not to move the grayscale strip and color

measurement page.

Click Continue to start the ColorCal measurement.

ColorCal B|

— Center the gray scale at the top of the ColorCal

measurement page and place on the scanner glass.

Press continue to initiske the scan.

| Continue | Cancel

When the measurement process completes, the Measurement dialog box appears.

Click OK to complete calibration.

Measurement

The measurement process was successiul.

To apply the ColorCal calibration, click Apply.

To close Calibrator, click Done.
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Calibrating with the DTP32 or DTP32 Series II

Using the DTP32 or DTP32 Series II densitometer, you can measure color patches generated
by the copier and automatically download the measurements to the GA-1310.

NoTE: Before you use ColorWise Pro Tools to calibrate the GA-1310, set up and calibrate the
DTP32 or DTP32 Series 1. For instructions, see the documentation that accompanies the
instrument.

To CALIBRATE THE GA-1310 USING THE DTP32 orR DTP32 SERIES II
1 Start Calibrator.

For instructions, see page 34.
2 In the Select Measurement Method pane, choose X-Rite DTP32 or X-Rite DTP32 Series II.
3 In the Check Print Settings pane, choose a calibration set.

If more than one option appears, choose the appropriate calibration set for the type of media
you use most often.

NoTe: For this calibration to take effect, the calibration set must be associated with one or
more output profiles. The default calibration set is already associated with the default output
profile. You do not need to make any new associations except for the Thick2 Paper, Thick3
Paper, or Thick4 Paper calibration sets, which are not associated with any default output

profiles.

4 Click Print in the Generate Measurement Page pane.
The Print Options dialog box appears.

5 Choose the appropriate options and click Print.
Page Type: Choose 21 or 34 Sorted Patches.

Paper Size: Automatically set to LTR/A4 for 21 Sorted Patches. Choose 11x17/A3 or
12x18/SRA3 for 34 Sorted Patches.

Input Tray: Specify the paper source.

Print Options: x|

Page Type

34 Sorted Patches

Paper Size

frxaziaz |

Irputt Tray
[euto select =l

Murmber of copies: |1 3:
Prirt | Cancel |

6 Retrieve the measurement page from the copier.
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7 Click Measure in the Get Measurements pane.

The Measurement Options dialog box displays the specified Page Type and
Paper Size options.

8 Click Measure.

Follow the on-screen instructions to feed the measurement page through the DTP32.

NoTe: The DTP32 Series II does not have an edge guide for the page. Position the page so
that the strip to be measured is lined up directly under the alignment mark.

The Status field displays instructions for selecting the port and feeding the measurement page
through the DTP32 four times, once for each color strip.

DTP32

Status Fort

_ - :

LA AN

Start
AOCERT |

L.Cancel |

DTP32 Series II

L AL N

Gtart |
Accept Cancel |

9 When the Status field indicates that the measurements were read successfully, click Accept.

10 Click OK in the Measure dialog box.
11 Click Apply in the Calibrator dialog box to implement the new calibration set.

12 Click OK in the Information dialog box.

This completes the calibration process.
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Calibrating with the DTP41

Using the DTP41 spectrophotometer, you can measure color patches generated by the copier
and automatically download the measurements to the GA-1310.

NoTE: Before you use ColorWise Pro Tools to calibrate the GA-1310, set up and calibrate the
DTP41. For instructions, see the documentation that accompanies the instrument.

TO CALIBRATE THE GA-1310 USING THE DTP41
1 Start Calibrator.
For instructions, see page 34.
2 Choose X-Rite DTP41 as the measurement method.
3 In the Check Print Settings pane, choose a calibration set.

If more than one option appears, choose the appropriate calibration set for the type of media

you use most often.

NoTE: For this calibration to take effect, the calibration set must be associated with one or
more output profiles. The default calibration set is already associated with the default output
profile. You do not need to make any new associations except for the Thick2 Paper, Thick3
Paper, or Thick4 Paper calibration sets, which are not associated with any default output
profiles.

4 Click Print in the Generate Measurement Page pane.
The Print Options dialog box appears.

5 Choose the appropriate options and click Print.

Print Options x|

Page Type

Paper Size
frizamiaz =l

Input Tray
Jeto Select =l

Murber of copies: I1 3:
Prirt | Cancel |

Page Type: Choose 21 or 34 Sorted Patches.

Paper Size: Automatically set to LTR/A4 for 21 Sorted Patches. Choose 11x17/A3 or
12x18/SRA3 for 34 Sorted Patches.

Input Tray: Choose the paper source for printing the measurement page.

6 Retrieve the measurement page from the copier.



CALIBRATION

7 In the Get Measurements pane, click Measure.

The Measurement Options dialog box displays the specified Page Type and Paper Size

options.

8 Click Measure.

9 If necessary, choose the appropriate COM port for the DTP41 from the Available Ports menu,

10 Feed the measurement page into the DTP41, starting with the cyan strip.

11

and then click Start Measurements.

Start -

Rite DTP-41

—Instructions

Fatch Info

Selectthe por that DTP-41 is connected to
and press "Start Measurements” to scan the
patch page.

34 Sorted Patches
1 Tik3

Available Ports
COM1 =

Start Measurements

Utilities

Measurements - X-Rite DTP-41 [ ]

—Instructions

Measure the cyan strip.

Position the strip so thatthe patches are directly under the alignment mark.
Insertthe strip pastthe frontidler rallers until it stops against the rear drive
rallers (approximately 3 inches). Click "Read Strip” when ready.

— Btatus

Port COM e e

Freyinus | IHEx

AccenthEABUTETTERTS | Cancel |

Align the page in the measurement page slot of the DTP41 so that the appropriate color
column is centered below the alignment mark. Insert the page about three inches, past the

front idler rollers, until it rests against the rear drive rollers and you feel resistance.

Click Read Strip.

The DTP41 pulls the measurement page through automatically.

After the measurement page is read, Calibrator instructs you to insert and align the page again

for the next color.
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12 Repeat the measurement process for the magenta, yellow, and black strips.

13

14
15
16

Measurements - X-Rite DTP-41 [ ]

—Instructions

Measure the magenta strip.

Position the strip so thatthe patches are directly under the alignment mark.
Insertthe strip pastthe frontidler rallers until it stops against the rear drive
rallers (approximately 3 inches). Click "Read Strip” when ready.

— Btatus
rhe cyan strip was read successfully.

Port COM1 o . Previous | e

AccenthEABUTETTERTS | Cancel |

A check mark appears on the circle of the color just read, and the Status field indicates the
color was measured successfully.

Use the Previous and Next buttons to reverse or advance to another step in the measurement
sequence.

When the Status field indicates that all four color strips have been read successfully, click
Accept Measurements.

Click OK in the Measure dialog box.
Click Apply in the Calibrator dialog box to implement the new calibration set.

Click OK in the Information dialog box.

This completes the GA-1310 calibration process.
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Calibrating with the ES-1000

Use ColorWise Pro Tools in conjunction with the ES-1000 spectrophotometer to calibrate
the GA-1310.

NoTE: Before you use ColorWise Pro Tools to calibrate the GA-1310, set up and calibrate the
ES-1000. For instructions, see the documentation that accompanies the instrument.

TO CALIBRATE THE GA-1310 USING THE ES-1000
1 Start Calibrator.
For instructions, see page 34.
2 Choose ES-1000 as the measurement method.
3 In the Check Print Settings pane, choose a calibration set.

If more than one option appears, choose the appropriate calibration set for the type of media

you use most often.

NoTE: For this calibration to take effect, the calibration set must be associated with one or
more output profiles. The default calibration set is already associated with the default output
profile. You do not need to make any new associations except for the Thick2 Paper, Thick3
Paper, or Thick4 Paper calibration sets, which are not associated with any default output

profiles.
4 Click Print in the Generate Measurement Page pane.
The Print Options dialog box appears.

5 Choose the appropriate options and click Print.

Print Options =

Page Type

Paper Size

fix7ias |
Inpaut Tray
o select |

Murnber of copies: I1 3:
Print | Cancel |

Page Type: Choose 21 or 34 Sorted Patches or 21 or 34 Randomized Patches. Sorted patches
are printed on the page in the order of their hue and saturation levels. Randomized patches
are printed on the page in random order, to help compensate for density inconsistencies on
different areas of the page.

Paper Size: Automatically set to LT'R/A4 for 21 patches. Choose 11x17/A3 or
12x18/SRA3 for 34 patches.

Input Tray: Automatically set to Auto Select.
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Retrieve the printed measurement page from the copier.
Click Measure in the Get Measurements pane.

The Measurement Options dialog box appears.

Measurement Dptions ﬂ

Page Type
|21 Sorted Patches =

Paper Size
[LTRiA =

Cancel

Page Type is automatically set to the type that you selected in step 5.
Check the settings and click Measure.

The Information dialog box appears.

I

@ Please place ES-1000 in its calibration cradle and click OK

Cancel |

Place the ES-1000 in the calibration cradle.

When you place the ES-1000 in the calibration cradle, white point calibration is used to
calibrate the spectrophotometer and compensate for gradual drifts in the instrument. Make
sure the sample aperture is in full contact with the white tile on the calibration cradle. If you
do not place it correctly in the calibration cradle, the spectrophotometer does not return
accurate measurements.

Click OK.

The Measurements dialog box appears. Instructions for measuring the strips appear in the

Status field.

EFI Spectrometer Measurements 5'

o] I [ e T

Aooent |
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For a more accurate measurement, place several sheets of plain white paper beneath the
Measurement Page.

The extra sheets block underlying colors from being read by the instrument.

Orient the Measurement Page so that strips are horizontal and the scan direction (indicated
by the arrows at the beginning of each strip) is left to right.

Hold the ES-1000 with its length perpendicular to the scan direction, and place the sample
aperture in the white space at the start of the specified color.

Press and hold the Measure button and wait for a beep or wait for the background color in the
dialog to change from green to white.

NoTe: To hear a beep with a Windows compatible computer, you must install a sound card
and speaker(s). You may have to turn up the volume on your computer to hear the beep.

After you hear a beep or see the dialog background color change, slide the ES-1000 at a slow
but consistent pace across the strip.

Take about five seconds to slide the length of the strip.

Release the button when all the patches in the strip have been measured and you reach the
white space at the end of the strip.

When a strip is measured successfully, the dialog background color changes to green, and the
cross hair moves to the next color. If the strip is not measured successfully, the dialog
background color changes to red, and a message directs you to try again.

Repeat steps 13 through 16 until all the strips are measured.
NOTE: You must measure in the order outlined in the Status field.
When all the patches have been read successfully, click Accept.
Click Apply in the Calibrator dialog box.

The new calibration measurement is applied.

Click OK in the Information dialog box.

This completes the GA-1310 calibration process.
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Calibrating from the copier touch panel

You can also calibrate the GA-1310 from the copier touch panel using ColorCal, without
using ColorWise Pro Tools Calibrator.

NoTe: To calibrate using ColorCal, you will need the grayscale strip included in the customer
media pack that came with your GA-1310.

Before you calibrate the GA-1310 from the copier touch panel, calibrate the scanner of the
copier using ColorWise Pro Tools, as described in “Calibrating with ColorCal” on page 38.

Calibrating with ColorCal

If an Administrator password has been set, you will need it to perform calibration from the
copier touch panel. For instructions on using the copier touch panel, see Configuration and
Setup.

To uSE COLORCAL FROM THE COPIER TOUCH PANEL
1 Press the Menu button and then press Fiery to display the GA-1310 screen.

2 Select Calibrate to display the calibration options.
3 If a password is set on the GA-1310, enter it and press Administrator.
4 Select settings for the calibration.

* DPage Size is set to LTR/A4.

* For Tray, choose the paper source for the patch page: Auto Select or Bypass.
NoTE: If you print a measurement page from the Bypass tray, you must load the appropriate
paper in the tray.

5 Select the Calibration Set.

Choose from the list of all calibration sets on the GA-1310. The calibration applies to only
one calibration set.

NoTE: For this calibration to take effect, the calibration set must be associated with one or
more output profiles. The default calibration set is already associated with the default output
profile. You do not need to make any new associations except for the Thick2 Paper, Thick3
Paper, or Thick4 Paper calibration sets, which are not associated with any default output
profiles.

6 Select Continue.

The ColorCal measurement page is printed. This page is comprised of swatches of color that
will be measured by the copier’s scanner and then compared to the target color values.

7 Retrieve the ColorCal measurement page.
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8 Place the grayscale strip face-down on the copier glass.

Place the strip along the top edge of the copier so that it is centered between the paper width
marks on the copier.

1 Place grayscale strip
face down

2 Place ColorCal measurement
page face down over
grayscale strip

9 Place the ColorCal measurement page face-down over the grayscale strip.
Make sure the patches on the grayscale strip do not overlap the color patches.

Close the platen glass cover, being careful not to move the grayscale strip and ColorCal
measurement page.

10 On the copier touch panel, select Measure Page.

Status messages display the progress of scanning and calculating measurements.
11 Wait for the display to indicate that the calibration is complete, and then click Continue.
12 Select Print to print a comparison of this calibration with the default calibration.

You can use this comparison to check the calibration results.

13 Select Yes to save the measurements and overwrite any previous calibration data in the
calibration set.
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Understanding calibration

Calibration allows you to:

* Maximize the color reproduction capabilities of the GA-1310.
* Ensure consistent color quality over time.

* Produce consistent output across GA-1310 servers.

* Achieve better color matches when reproducing spot colors, such as PANTONE colors or

other named color systems.

* Optimize the GA-1310 for using ColorWise rendering styles (CRDs), CMYK

simulations, and ICC profiles.

The following sections describe important concepts and suggestions for understanding
calibration.

An overview of calibration

Calibration generates corrections that, when applied to the color data in a job, adjust for the
difference between the actual (measured) toner densities and the desired densities that the
output profile uses.

* Calibration measurements represent the actual color behavior of the copier.

* A calibration set references a particular set of measurements and is associated with specific
printing conditions (print option settings).

* Each output profile contains a calibration target that describes the desired behavior of the
copier.

After you calibrate the GA-1310, a calibration set is stored. This calibration set is used when it
is associated with an output profile. Every output profile has an associated calibration set. If
you have not specified one, the calibration set associated with the default output profile is
used.

If you change the calibration after a saved job has been processed (RIPped), you do not have
to reprocess (reRIP) the job. The new calibration affects the job without reprocessing.

NoTe: Changing calibration has the potential to affect a// jobs for a/l users, so consider
limiting the number of people authorized to perform calibration. Set an Administrator
password in GA-1310 Setup to control access to calibration (see Configuration and Setup).
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How calibration works

Success in obtaining satisfactory color quality from the GA-1310 depends on many factors.
Among the most important are establishing and maintaining optimal toner densities. The
density is the measure of the light absorbed by a surface. By carefully regulating toner
densities, you obtain consistent printed color.

Even with a calibrated system, toner density is affected by the settings of copier, humidity, and
temperature. Density also tends to drift over time. Uneven toner density on paper affects
calibration results. Regular measurement of toner density detects day-to-day variations in
color quality, and calibration corrects for these variations.

In calibration, the GA-1310 compares measured density values to the target values for each of
the four toner colors (CMYK). The target values are based on the output profile associated
with the calibration set. The GA-1310 generates a set of correction functions (represented as a
set of CMYK input/output density curves) that compensate for the difference between actual
(measured) and desired (target) density values.

Output profiles and calibration sets

A calibration set references a particular set of measurements and the corresponding color
corrections that the GA-1310 applies to compensate for the variation between these
measurements and the desired color output of the copier. A calibration set is associated with
one or more print option settings that were used to obtain the measurements.

The needs of most users are met by the default calibration set. If more than one calibration set
is available, you can choose a calibration set with alternative print option settings to customize
calibration for specialized jobs. You can then print with that calibration set by choosing an
output profile that you have associated with the calibration set.

When you calibrate the GA-1310, you select the calibration set by selecting the print option
settings associated with the calibration set. Choose a calibration set that corresponds to the
typical printing jobs at your site. This same calibration set can be associated with one or more
output profiles. For more information about output profiles, see page 88.

Measurements

Calibration measurements are stored in files as numerical values that correspond to the toner
density produced by the copier when it prints solid cyan, magenta, yellow, and black, and
graduated tints of those colors. When you calibrate the GA-1310, you create a measurement
file by first printing a page of color patches and then measuring the patches using a color
measurement instrument. The measurements are automatically downloaded to the GA-1310.
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Scheduling calibration

Calibrate the GA-1310 at least once a day, depending on the volume of print jobs.

If it is very important to maintain consistent color, or your copier is subject to wide
fluctuations in temperature or humidity, calibrate every few hours. For optimal performance,
calibrate whenever there is a noticeable change in print quality or printing results are not as
expected.

If you must split a print job into two or more batches to print at different times, it is
important to calibrate before you print each batch. You should also calibrate the GA-1310
after copier maintenance. However, because the copier may be less stable immediately after
maintenance, wait until you have printed approximately 50 pages before you calibrate.

NoTE: Because printed output from the copier is very sensitive to changes in temperature and
humidity, do not install the copier near a window, in direct sunlight, or near a heater or air
conditioner. Paper is also sensitive to climate changes. Store it in a cool, dry, stable
environment, and keep reams sealed until they are used.

To monitor print quality, print the following color pages:
* Color Charts (from Command WorkStation or the copier touch panel)

* Color reference pages included in the User Software DVD (see pages 12 and 16)

These pages include fully saturated color patches and pale tints of cyan, magenta, yellow,
and black. Images with skin tones offer a good basis for comparison. Save and periodically
compare the pages you print. If a noticeable change in appearance occurs, calibrate the

GA-1310.

When you examine the Test Page, all color patches should be visible, even though they may be
very faint in the five to two percent range. Each patch set should show uniform gradation
from patch to patch as the color lightens from 100% to zero.

If the solid density patches (100% cyan, magenta, yellow, or black) look less saturated over
time, show the pages to your copier service technician to determine whether adjusting the

copier can improve output.

For more precise calibration, select the 600 DPI Print setting for the print calibration on the
copier before calibrating the GA-1310. To locate this setting, press User Functions and go to
Admin > General > Calibration.

NoTE: 1200 DPI is not available for this function.
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Checking calibration status

To verify whether the GA-1310 is calibrated, which calibration set and output profile were
used, and when the copier was last calibrated, perform the following:

* Print a Configuration page or Test Page from the copier touch panel or Command
WorkStation.

For instructions on printing the Configuration page, see Configuration and Setup.

*  Select a calibration set in Calibrator. The last calibration and the user who performed it
are displayed.
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The Spot Color Matching print option automatically matches spot colors with their best
CMYK equivalents so that spot colors can be simulated using the CMYK toner of the copier.
However, you may want to adjust the default CMYK equivalents to achieve a better match for
your specific printing conditions. You can modify spot colors using Spot-On.

In addition to managing “named” colors, Spot-On allows you to create a list of “substitute”
colors. These are colors that, when called for in a document by their RGB or CMYK values,
are substituted with a different color having the CMYK values from the Spot-On color
dictionary. This permits exact color control and overrides individual RGB and CMYK colors.

Using Spot-On

Spot-On allows you to adjust and manage lists of spot colors and their CMYK equivalents.
The matching lists of spot colors and CMYK values are known as Spot Color Dictionaries.
Spot-On allows you to maintain multiple Spot Color Dictionaries for each output profile on

the GA-1310.
NoTE: Spot-On is an optional feature for the GA-1310.

NoTe: To use the Spot-On features with named colors, you must enable the Spot Color
Matching print option. For more information about this option, see page 93.

NoTEe: Spot colors identified by names are printed with their defined CMYK values. The edits
to the output profile made with Color Editor do not affect how spot colors print.

Some Spot-On features require that a job be displayed with correct colors on your monitor.
To display the colors correctly on your monitor, you must set up the monitor display
according to the manufacturer’s recommendations, and specify the correct monitor profile for
your monitor.

Specify the following settings for the monitor display:
* At the monitor: Brightness, Contrast, and Color Temperature

* From the control panel of the operating system: Resolution, Refresh rate, and Number
of colors

For more information about setting up your monitor and the monitor profile, see the

documentation that accompanies the monitor.
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Starting Spot-On

To use Spot-On, you must specify the output profile associated with the Spot Color
Dictionary that you want to edit.

If you select Output profile X and redefine PANTONE 123 from 30%M to 50%M using
Spot-On, you will get 50%M when you print a job with Output profile X. If you print a job
with Output profile Y, you will get the original value. If you select Output profile X and create
a custom color named “My Purple” and define it as 80C 40M, ColorWise automatically
calculates the Lab values using Output profile X and creates new CMYK values for use with
Output profile Y.

NoTe: The GA-1310 allows only one user to connect to Spot-On at a time.

To START SPOT-ON
1 Start ColorWise Pro Tools and connect to the GA-1310.

EE ColorWise Pro Tools
File Tools Help

Lero_=device names=

%

Calibrator Color Editor | Profile Manager 2 Colar Setup

2 Click Spot-On.
The Select Output Profile dialog box appears.
3 Choose an output profile and click OK.

Select Dutput Profile
1 Current output profile
2 Output profiles to link

Current Output Profile

Edit spot colors for this output profile:

@<proflle names |

The Spot-On main dialog box appears. The CMYK values displayed in the dialog box are
calculated with respect to the specified profile.

NoTe: When you print a job, choose the same output profile from the printer driver as the
one that is selected in the Select Output Profile dialog box. Otherwise, color adjustments
based on Spot-On have no effect.
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Spot-On main window

The Spot-On main window list color groups that represent libraries of spot colors on the
GA-1310. Tool icons for working with colors appear at the top of the window.

PAspot-On  Output Profile: 10l =|

FiIEdinstnt (6);(7):(8)(9)-(10 (11)
T

Color Names C 1 Ay K

% My Colors @ =l

DI Color Guide (2007)

System

HKS E (Continuous Forms) (2007

2 HKS K (Coster!) (2007) 13

HKS M (Uncosted) (2007)

= HWE Z (Newwspaper) (2007)

Ny PANTONE Coated

By default, the GA-1310 includes several PANTONE libraries along with a System library.
These factory default libraries appear marked with the default group icon (&2

The DIC, HKS, and TOYO libraries are also available with Spot-On.

You can add custom color groups and colors to the Spot-On window (see page 61). Added
groups appear marked with the custom group icon (% ). Both default and custom groups
can be opened to display included colors.
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59

To OPEN AND CLOSE A COLOR GROUP

1 To open a color group, double-click the icon to the left of the group name.

When you open a group, all the colors in the group are displayed, and the group icon changes

appearance.

File Edit Instrument

msDDt—Dn Dutput Profile: <profile name:=

System

PANTOMNE Costed

O “ellowe

1

100

O el 012

1

100

. Orange 021

57

100

. Warm Red

925

a5

. Red 032

a5

865

. Rubirie Res!

995

265

. Rhodamine Red

2

935

3

. Purple

349

935

25

. Vilet

g5

99

3

1}

s oo

A

A

A

n

=

2 To close a color group, double-click the icon to the left of the group name.

3 To close all the color groups in the list, choose Close All from the Edit menu.
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Working with existing colors

Spot-On allows you to view and manage existing groups of colors on the GA-1310 and search
for a particular color in the Spot-On list.

Color groups in the Spot-On window appear in order of their priority. Highest priority is
assigned to color groups at the top of the list. For instance, if two colors from two different
color groups have the same name, the GA-1310 uses the color from the higher group and
disregards the other color. By managing the priority of colors in this way, you can maintain
several CMYK variants for the same spot color.

To REARRANGE THE PRIORITY OF COLORS

1 To rearrange an entire color group, select the desired color group.
To rearrange an individual color, select the desired color.

Individual spot colors are marked with circular color icons.
2 To move the selection up or down in the list, click the Up or Down icon in the toolbar.

3 To paste the selection in a different location in the list, click the Cut or Copy icon in
the toolbar.

NoTe: The Cut operation is available only for custom colors.

4 Click the location in the list where you want to paste the cut or copied selection, and then
click the Paste icon in the toolbar.

When you paste a default PANTONE color or group, a warning message appears asking you
to rename the selection because of the multiple prefixes and suffixes for the PANTONE
colors and groups. Use the menus to choose the desired prefix and suffix for the new name,
and then click OK. The pasted selection becomes a custom color or group with the specified

name.
Rename Color

' The colorgroup you are aboutto

L. paste has multiple prefix and/or

suffix infarmation.
Prefix Suffix
FANTOMNE | [c =l
oK Cancel
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TO FIND A SPECIFIC COLOR

1 Choose Find from the Edit menu.
The Find dialog box appears.
2 Enter the name of the color that you want to find and click OK.

Spot-On searches for the specified color, starting from the top of the color list. Once located,
the color appears selected in the color list.

3 To find additional colors based on the same search criteria, choose Find Again from the
Edit menu.

Creating custom colors

Spot-On provides a number of default color groups in the color list. You can add your own
custom spot colors and groups to the list.

To ADD A NEW COLOR OR COLOR GROUP

1 Select the location in the group or color list where you want the addition to be placed.

2 Choose New Group from the Edit menu to insert a new group, or choose New Color to insert a
new color.

A new color group entry or color entry appears as Untitled.

To RENAME A CUSTOM COLOR OR GROUP

1 Select the specific color or group that you want to rename.
2 Double-click the name of the color or group.

3 Type the new name exactly as it appears in the job, including uppercase and lowercase
characters and spaces, as needed.

This new name is supplied by the source application (such as Adobe Illustrator or
QuarkXPress) to your PostScript job.

NoTe: Default groups or colors (such as PANTONE) cannot be renamed.



Downloading custom color groups

You can download custom color groups from your computer to the GA-1310. Downloaded
groups are added as custom groups to the Spot-On color list and are immediately enabled for
use on the GA-1310.

To DOWNLOAD CUSTOM COLOR GROUPS

1 Select the location in the color list where you want to add the downloaded group.
2 Choose Download from the File menu.

The Select file dialog box appears.

4
Lok in: ID color ﬂ ﬁ

| AdoheRGE1998 icc ®| gendd3220cm | g2
[#8] adodksZ2 om [#] Hitacki Compatible S300K G2 2icm ] mnp2
[38] appofst A iem [#] Japanstandard ico ] MEC ¢
(] &ppleRGE icc [#] mnb22g15 icm ] MTSC
|=8] CIERGE jcc ] mnb22g18.icm ] rtscic
[s8] ColorMatchRGE oo [#] mnb22g21 icm ] P
[=] Dismand Camgatible 9300k 522 jcrm #] mnekug! 5 jom ] Phatc
Q EuroscaleCoated icc E mnebug! &.icm a Phatc
a EurozcaleUncoated ico a mnebug21 icm a racds
9 gencdd318.icm @ MNp22g15icm Q SMPT

| | |
File hame: || &I
| Files of type: | icciict Files j Cancel

NoTe: Although many ICC profiles may be shown, you can only download an ICC Named
Color Profile.

3 Locate and select the desired color group, and then click Open.

The downloaded group is added to the specified location in the Spot-On list. If you did not
specify a location, the group is added to the top of the list.

If the downloaded group has the same name as an existing group in the list, you are prompted

to rename the downloaded group.



SPoT-ON

Uploading custom color groups

You can upload custom color groups from the GA-1310 to your computer as ICC files. The

upload feature allows you to share a group by creating a local copy that can be downloaded to
another GA-1310.

You must save a color group to the GA-1310 before you can upload it to your computer. To
upload a factory default group, copy and paste the group as a new custom group, and then
upload the group as required.

To UPLOAD CUSTOM COLOR GROUPS
1 Select the name of the color group you want to upload.

2 Choose Upload from the File menu.

The Save As dialog box appears.

Save As: HE
Save i Iﬁ Colofwize Pra Tools j gl
com @ EFID ersitometer1 00.CH @ monitorProfile.icc

libraries i OLL Platforms pecific.dll
ProfileCache jspWinMm.OLL Preferences - Spat |
ColorwisePro.exe jspWinAni DLL
ColorwizePro.jar jspWinRnia DLL
cwvicc.dll log. kst
L« | 2
File hame: MylGroup.icg Save I
Save as ype: IA\I Files [*7] j Cancel |

3 Browse to the location where you want to save the file, name the file, and then click Save.
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Editing color values

If an existing spot color is not printing as intended, edit the color values as needed to achieve
your intended result. Edit color values by entering the exact CMYK values in the Spot-On
main window or in the Set Center Patch Color dialog box, or using the Spot-On Color

Search feature.

Use the following procedures to edit a named color by entering the exact CMYK values. To
target a color using Spot-On Color Search, see page 65.

TO EDIT A COLOR IN THE SPOT-ON MAIN WINDOW

1 Select the color you want to edit.

2 Double-click the value under C, M, Y, and K, and enter a new number for each color channel.

File Edit  Instrument

ESput-Un Dutput Profile: <profile name>

YooK |
=
% PANTONE Casted
O “ellaw 5] 1 100 0
{:) Vellow 012 [T
. Orange 021 F T

The edited color appears in the color list.

NoTe: The edited color is not saved until you choose Save from the File menu.

To EDIT A COLOR IN THE SET CENTER PATCH COLOR DIALOG BOX

1 Select the color you want to edit.

2 Double-click the color icon.

The Spot-On Color Search dialog box appears with the selected color in the center.

3 Click the center patch.

The Set Center Patch Color dialog box appears.

Set Center Patch Color x|

Enter the values desited for the center patch colar

Enter CMYK values as

" Device Codes (0 - 255)

be e [ lu

Qld Ty

I’I oo W ID K
OK | Cancel |
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4 Indicate whether you want to enter CMYK values as percentages or Device Codes.

The Percentages option allows you to enter color values between 0 and 100%, in increments
of 0.5. Values out of this range are rounded to the nearest whole or half percentage.

The Device Codes option allows you to enter color values between 0 and 255. This option
reflects the full range of color values that the GA-1310 can reproduce and provides finer
gradations of color than are possible with Percentages.

5 Enter the C, M, Y, and K values of your specific color in the appropriate fields.

Use the Tab key to move from field to field. As you enter each new value, the preview patch
updates to reflect the old and new colors.

6 Click OK.
The new color is displayed in the center of the Spot-On Color Search dialog box.
7 Click OK.

The edited color appears in the color list of the Spot-On main window.

Use the following procedure to target a color using the Spot-On Color Search dialog box.
Beginning with an approximate color in the Spot-On Color Search dialog box, adjust the hue,
saturation, and lightness of the color until you achieve an acceptable match.

TO TARGET A COLOR USING SPOT-ON COLOR SEARCH

1 Select the color that you want to edit.
2 Double-click the color icon.

The Spot-On Color Search dialog box appears with the current color in the center.

Spot-0On Color Search...Yellow x|

!

Color Spacing Color Directions Legend ————————— Colorant Levels

Bl E0 “EC~  EC
(] ) ] - ) ] (- (] ]
EE vEEv

 Lightness + Saturation

[¥ monitor Cormpensation

Pririt Pattern Revert Factory Color [o].4 Cancel
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3 To update the center patch to a neighboring color that more closely matches the target, click
the corresponding neighbor patch.

Neighboring patches represent variations from the center patch and can be selected if they
offer a closer match to the desired color. Clicking one of these patches updates the center
patch to the new color and provides a new selection of neighboring colors. These patches are
either lightness or saturation neighbors, depending on the option you choose in the following
step.

NoTE: When you select certain colors, an exclamation point icon may appear in the
upper-right corner of the dialog box. This icon indicates that one or more colorants have

reached their maximum values.
4 Use the following techniques to control how neighboring color patches are generated:
Select Lightness or Saturation in the Color Directions Legend.

Lightness generates neighbor patches based on darker to lighter shades of the original color.
This variation is displayed from left to right, with the original color remaining in the center of
the middle group.

Saturation generates neighbor patches based on less saturated to more saturated variations
of the original color. This variation is displayed from left to right, with the original color
remaining in the center of the middle group.

Choose a setting from the Color Spacing menu to control the closeness of the neighbor
patches.

A higher setting generates neighbor patches that differ more noticeably from the center color.
As you get closer to your target color, reduce the color spacing to a smaller value.

Select Monitor Compensation to simulate how all the on-screen color patches will appear
when printed on paper.

This simulation depends on the monitor profile that has been configured for your monitor.
To specify the monitor profile, choose Preferences from the Edit menu in the Spot-On

main window.

Make sure that you set your monitor according to the manufacturer’s recommendations and
select the correct monitor profile for your monitor.

5 Continue adjusting the color patch controls and clicking neighbor patches until the color you
want appears in the center patch.

6 Click Print Pattern.

Note: It is very difficult to accurately match spot colors on a monitor. You should always test
print to get the proper color match.



SPoT-ON

7 Choose the appropriate settings from the Output Style, Paper Size, and Paper Tray menus.

Print Setup
Qutput Style
=
Paper Size
JLmias =l
Paper Tray
[auto Select =l

For Output Style, choose Color Search Pattern or Color Neighbor Pattern. Color Search
Pattern prints patches with the same pattern as displayed in the Color Search dialog box.
Color Neighbor Pattern prints patches in a three column by eight row format.

For Paper Size, choose the size of the paper that you want to use for printing the patches.
For Paper Tray, specify the paper source for the paper that you want to use.
8 Click OK to print the patches.
The Print Pattern test page provides the following information:
* Center patch color CMYK value
* Color spacing
* Lightness or Saturation neighbors selected
e Output profile selected

The goal of Spot-On Color Search is to find the color values that make a printed color patch
match a target, not its screen simulation of it. Printing a Print Pattern of neighbor color
patches allows you to compare the printed patches to the color target. After you compare the
printed patches and find the one that matches most closely, you can select the corresponding
patch on-screen.

9 Select the desired target color in the Spot-On Color Search dialog box and click OK.

The edited color appears in the color list of the Spot-On main window.
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Using a measurement instrument to target colors

If you have the Spectrophotometer ES-1000, you can import measured color values directly
into Spot-On. This feature allows you to target matches based on the actual colors of
immediate objects, such as the red of a printed logo or the yellow of a packaging envelope.

To IMPORT COLOR MEASUREMENTS INTO SPOT-ON

1

Install and set up the ES-1000 for use with your computer.

For installation and setup instructions, see the documentation that accompanies the

instrument.
Choose Start from the Instrument menu in the Spot-On main window.
The Choose Instrument dialog box appears.

For Instrument, choose the instrument you will use to take measurements. For Port, choose
the serial port connection of the instrument. Click OK.

Place the ES-1000 over the target color, making sure to center the sample aperture over the
color. Press Measure to take the measurement.

The measured CMYK values are imported into Spot-On as follows:
* Ifan individual color is selected in the color list, it updates to the measured color.

* Ifagroup is selected in the color list, a new color with the measured values is created

within the group.

* If the Spot-On Color Search dialog box is open, the center patch updates with the
measured values, and the neighbor patches update accordingly.

* If the Set Center Patch Color dialog box is open, the measured values are imported into

the CMYK entry fields.
When you are finished taking color measurements, choose Stop from the Instrument menu.

Spot-On closes the connection to the instrument.
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Reverting default colors to factory settings

You can revert default colors to their factory default settings. Revert all colors within a default
color group, or revert one or more specific colors within a default color group, so that only
those colors are reset to the factory default settings.

TO REVERT ALL COLORS WITHIN A DEFAULT COLOR GROUP TO FACTORY DEFAULTS
1 Click the icon to the left of the name of the group that you want to revert.
2 Choose Revert Group from the File menu.
A warning message appears.

3 Click OK.

To REVERT SPECIFIC COLORS WITHIN A DEFAULT COLOR GROUP TO FACTORY DEFAULTS

1 Click the icon to the left of the name of the group that contains the colors you want
to revert.

2 Select the colors that you want to revert to the factory defaults.

To select more than one color, Shift-click to select an adjacent color or Control-click to select
a nonadjacent color.

3 Choose Revert Factory Color from the File menu.

A warning message appears.

4 Click OK.
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Saving changes and exiting Spot-On

To enable your spot color matches for use with the GA-1310, save your edits before you exit
Spot-On. This ensures that all your changes to Spot-On color definitions are stored on the
GA-1310 and available for use when printing documents that contain spot colors.

The following edits do not require saving to take effect:
* Rearranging the priority level of a color group
* Downloading a color group

* Clearing or deleting a color group

To SAVE THE SPOT-ON COLOR LIST

1 Choose Save from the File menu.

2 Click Close in the upper-right corner of the Spot-On main window to exit the utility.

Spot-On with Substitute Colors

The Substitute Colors workflow involves defining the substitute color values with Spot-On,
and then printing a document with the Substitute Colors print option set to On from the
printer driver. You can also override the print option setting using Command WorkStation.

NoTe: Color substitutions affect only text, vector, and line art. They have no effect on
raster images.

NoTe: When a color is defined as a substitute color, the settings for an RGB color (such as
RGB Source, Rendering Style, and RGB Separation) or CMYK color (such as CMYK
Simulation Profile and CMYK Simulation Method) have no effect. The color is converted
with a process similar to spot color conversion.
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Creating a color for substitution

Use the following procedure to add a new substitute color in a substitute group and specify

the value-name for a color to substitute.

NoTE: A new substitute color can be added only to a substitute group.

TO ADD A NEW SUBSTITUTE COLOR AND SPECIFY THE VALUE-NAME FOR SUBSTITUTION
1 Start ColorWise Pro Tools and connect to the GA-1310.

Start ColorWise Pro Tools from a stand-alone application or Command WorkStation, at your
computer or at the monitor connected to the GA-1310.

ColorWise Pro Tools

% %

Calibrator Color Editor | Profile Manager Color Setup

2 Click Spot-On.
The Select Output Profile dialog box appears.
3 Select an output profile and click OK.
The Spot-On main window appears.
4 Select the location in the group list where you want the addition to be placed.
5 Choose New Substitute Group from the Edit menu.
A new substitute group entry appears as Untitled.
6 Double-click Untitled and type a new name.

7 Select the substitute group and choose New Substitute Color from the Edit menu.

NoTe: If the substitute group already contains substitute colors, select the color above the
location where you want to add a new substitute color.

The Add Substitute Color dialog box appears.

enn Add Substitute Color

Substitute Color: Tolerance:
@ CMYK (0-100%) @ small
) RGB (Device Code 0-255) O Large
O RGE (0-100%)

b bc 0 %m 0 %y |0 %k

OK Cancel

8 Select a color mode for the substitute color.
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Select a tolerance degree for the substitute color.

For information about Tolerance, see page 77.

Type the values for the color that you want to substitute.
Click OK.

The substitute color appears at the specified location.

Defining the color values for a substitute color

After you specify the original color to substitute, define CMYK values for the substitute color
by typing the exact CMYK values in the Spot-On main window or Set Center Patch Color
dialog box, or use Spot-On Color Search.

For instructions on defining a substitute color by typing the exact CMYK values, see the
following sections. To define a substitute color in the Spot-On Color Search dialog box,
see page 74.

To DEFINE A SUBSTITUTE COLOR IN THE SPOT-ON MAIN WINDOW

1
2

Start ColorWise Pro Tools and connect to the GA-1310.
Click Spot-On.

The Select Output Profile dialog box appears.

Select an output profile and click OK.

The Spot-On main dialog box appears.

Select the color that you want to substitute.

@ O O Spot-On Output Profile: m

SIS SISET AEY

Color Names

K

{ NewSubstituteGroup
B <100.0¢,0.0m,0.0v,0.0k>
System

(3 PANTONE Coated

3 PANTONE Metallic Coated

Double-click the value under C, M, Y, and K, and type a new number for each color channel.

The new values for the substitute color appear in the color list.

NoTEe: The edited color is not saved until you choose Save from the File menu.
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TO DEFINE A SUBSTITUTE COLOR IN SET CENTER PATCH COLOR

1 Select the color that you want to substitute.
2 Double-click the color icon.

The Spot-On Color Search dialog box appears with the selected color in the center.

1 Center patch @ O ) Spot-On Color Search...<100.0¢,0.0m,0.0y,0.0k>

HE EE HEE °
HEE BN EEN
Hl HEE BN

Color Spacing Color Directions Legend————— Colorant Levels

5 ) mEO +“mEC~ 00
(] ) -+ [ o (- [ ][] [
EN EE« ©HE

(O] Lightness () saturation

# Monitor Compensation

Print Pattern Revert Factory Color ( 0K ) ( Cancel ]

3 Click the center patch.

The Set Center Patch Color dialog box appears.

enn Set Center Patch Color

Enter the values desired for the center patch color.

Enter CMYK values as:
® Percentages (0 - 100)

() Device Codes (0 - 255)

Old  New
100 C 0 M 100 Y D K

4 Type values for each C, M, Y, and K color channel.

For information about using Set Center Patch Color, see page 64.
5 Click OK.

The new color appears in the center in the Spot-On Color Search dialog box.
6 Click OK.

The new color appears in the color list of the Spot-On main window.

NoTe: The edited color is not saved until you choose Save from the File menu.

Use the following procedure to target a substitute color using the Spot-On Color Search
dialog box.
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To DEFINE A SUBSTITUTE COLOR USING SPOT-ON COLOR SEARCH
1 Select the color that you want to substitute.

2 Double-click the color icon.

The Spot-On Color Search dialog box appears, displaying the current color in the center.

1 Neighboring patch © O ) Spot-On Color Search...<100.0¢,0.0m,0.0y,0.0k>

HEE ELN EE ©
HEE EEE BEEN
Hl HEE BN

Color Spacing Color Directions Legend————— Colorant Levels
59 mE «ECx [0
() ) o - [ o |- ][]
E cEEs S5

(O] Lightness () saturation

# Monitor Compensation

Print Pattern Revert Factory Color - ( 0K j ( Cancel ]

3 Click neighboring patches until you find the color that you want to use for the substitution.

For information about using Spot-On Color Search, see page 65.

4 Click OK.

The new substitute color appears in the color list of the Spot-On main window.

NoTe: The edited color is not saved until you choose Save from the File menu.
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Printing a job with a substitute color

After you define CMYK values for substitution in Spot-On, you can print a document and
specify in the printer driver that the substitute color be used. You can also specify this print
option for an existing print job by overriding the job’s properties in Command WorkStation.

NoTE: When you print the job, select an Output Profile setting from the printer driver that
matches the output profile you selected in Spot-On to define the color substitution.
Otherwise, the color substitutions that are defined on Spot-On have no effect.

NoTe: The procedures for printing a job from a Mac OS and a Windows computer
are similar. The following procedure shows the Mac OS version.

To PRINT A JOB WITH A SUBSTITUTE COLOR

1 Open a document in your application.
2 Choose Print.

3 Mac 0S X v10.5 only: Expand the dialog box, if necessary, by clicking the arrow next to the
Printer name.

4 Mac 0S X v10.3.9 and 10.4.x: Click Copies & Pages and choose ColorWise from the menu.
Mac 0S X v10.5: Click Preview and choose ColorWise from the menu.

The Color pane appears.

Printer: = AERO_Print

Presets:  Standard

ColorWise

Print Mode

) Standard Color

() Expert Color Expert Settings...

) Grayscale

gﬁlack Detection

] Composite Overprint
] Substitute Colors

I Combine Separations

] Auto Trapping

] Two Way Communication

Printer Address

( PDF v ) (Preview) (Supplies,, ) (Standard) ( Cancel ) ‘—hﬂ—)

5 Select Substitute Colors.
6 Click Print.

The job is printed with the substitute you defined in Spot-On.
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Substitute Color dialog box

You can define the color mode and tolerance range for a substitute color in the Add Substitute
Color or Rename Substitute Color dialog box.

enn Add Substitute Color

Substitute Color: Tolerance:
@ CMYK (0-100%) @® small
) RCB (Device Code 0-255) O Large
) RGB (0-100%)

o e 0 %m 0 %y |0 %k
( OK Cancel |
o Tt

NoTe: The Add Substitute Color dialog box appears when you choose Edit>New Substitute
Color after selecting a substitute color group in the list. The Rename Substitute Color dialog
box appears when you double-click the bracketed section of a substitute color.

NoTe: The Add Substitute Color and Rename Substitute Color dialog boxes offer the same
control in defining a substitute color.

* Substitute Color: Select the following color modes for a substitute color:
— CMYK (0-100%)
— RGB (Device Code 0-255)
— RGB (0-100%)
* Tolerance: Select the following tolerance ranges for a substitute color:
— Small (indicated in lowercase)

— Large (indicated in uppercase)
To avoid entry errors, the Add Substitute Color and Edit Substitute Color dialog boxes

display the values in the following predefined formats. The dialog boxes also display

uppercase or lowercase characters and a “%” symbol, depending on the selections.
e (CMYK (0-100%) mode
— Small: <“0”%c, “0”%m, “0”%y, “0”%k>
— Large: <“0”%C, “07%M, “0”%Y, “07%K>
* RGB (Device Code 0-255) mode
— Small: <“0”r, “0”g, “0”b>
— Large: <“0”R, “07G, “0”B>
* RGB (0-100%) mode
— Small: <“0”%r, “07%g, “0”%b>
— Large: <“0”%R, “0”%G, “07%B>
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Principles for Substitute Colors

In setting the values for Substitute Colors, keep in mind the following principles.

Tolerance range

The accuracy of the substitute color is affected by various elements, such as applications,
operating systems, printer drivers, and distilling processes. To accommodate the “errors” that
occur because of the rounding rules between the numbers entered by users and the numbers
received by the GA-1310, the options of the small and large tolerance ranges are provided for
color substitution.

The following table provides Small and Large substitution tolerance ranges for each

color mode.

Color mode Small tolerance range Large tolerance range
CMYK (0-100%) +/-0.25% +/- 0.5%

RGB (Device Code 0-255) +/-0.25 +/-1

RGB (0-100%) +/-0.25% +/-0.5%

NoTEe: Values for tolerance ranges are approximate.
o CMYK (0-100%)
— Small: A substitute color replaces any color that falls within the nearest +/- 0.25% of
the color value entered.
— Large: A substitute color replaces any color that falls within the nearest +/- 0.5% of the
color value entered.

* RGB (Device Code 0-255)

— Small: A substitute color replaces any color that falls within the nearest +/- 0.25 of the
color value entered.
— Large: A substitute color replaces any color that falls within the nearest +/- 1 of the
color value entered.
* RGB (0-100%)
— Small: A substitute color replaces any color that falls within the nearest +/-0.25% of the

color value after scaling.

— Large: A substitute color replaces any color that falls within the nearest +/-0.5% of the

color value after scaling.



SPoT-ON

Color substitution

A color substitution takes place when a substitute color is defined with a different set of
CMYK values for the same value-name as the original color.

The following color examples show how a substitution works.
* Original color: <100, 0, 0, 0> for the CMYK values (cyan)
e Substitute 1: <0, 100, 100, 0> (red)

* Substitute 2: <100, 0, 100, 0> (green)

¢ In the examples, the extreme values and terms “red” and “green” are used for illustrative
NoTE: In th ples, the ext 1 dt d” and “g d for ill t
purposes only. In practice, color substitution is not used for extreme color shifts.

The following table shows color substitution with different sets of CMYK values assigned to
the same original color.

Substitution CMYK Before After

value-name values substitution substitution
Original color — <100, 0, 0, 0> — —
Substitute 1 <100.0c, 0.0m, 0.0y, 0.0k> <0, 100, 100, 0> cyan red
Substitute 2 <100.0c, 0.0m, 0.0y, 0.0k> <100, 0, 100, 0> cyan green

Priority scheme

If two substitute colors are defined with the same value-names, but with different sets of
CMYK values and different tolerance ranges, Spot-On resolves the priority of substitution
according to the order of color in the group.

Spot-On process color substitution is based on the order of color in the group. The color
entries at the top of the list have priority over the colors at the bottom of the list. Spot-On
scans the list from top to bottom and processes substitution in linear order. When a color is
remapped, it is not overridden by any subsequent substitution call.

The following color examples show how the priority scheme works.
* Original color: <100, 0, 0, 0> for the CMYK values (cyan)
¢ Substitute 3: <0, 100, 100, 0> (red) with a small tolerance

* Substitute 4: <100, 0, 100, 0> (green) with a large tolerance

NoTE: In the examples, the extreme values and terms “red” and “green” are used for
illustrative purposes only.

Order of the colors
* Case 1: Substitute 3 (red) is higher than Substitute 4 (green) in the list.

* (Case 2: Substitute 4 (green) is higher than Substitute 3 (red) in the list.
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The following table shows the scheme of priority when the same value-names are assigned to

the original color with different sets of CMYK values and different tolerance ranges.

Color Substitution CMYK values Before After

order value-name substitution substitution
Original color <100, 0, 0, 0>
Case 1 Substitute 3 <100.0c, 0.0m, 0.0y, 0.0k> <0, 100, 100, 0> cyan red

Substitute 4 <100.0C, 0.0M, 0.0Y, 0.0K> <100, 0, 100, 0> (see the following)
Case 2 Substitute 4 <100.0C, 0.0M, 0.0Y, 0.0K> <100, 0, 100, 0> cyan green

Substitute 3

<100.0c, 0.0m, 0.0y, 0.0k> <0, 100, 100, 0>

(see the following)

Substitute 3 and Substitute 4 have the same value-names, but depending on their order in the

list, Spot-On produces different results.

* In Case 1, Substitute 3, red, is given higher priority because it is higher in the list. All

occurrences of the original color, cyan, within the Small tolerance range are substituted

with red. Occurrences of cyan within the Large tolerance range but not within the Small

tolerance range are substituted with Substitute 4, green.

* In Case 2, Substitute 4, green, is given higher priority because it is higher in the list.

Substitute 3, red, can only substitute for occurrences of the original color, cyan, within the

Small tolerance range, and those occurrences have already been substituted with green.

Therefore, no substitution with red takes place.

Uploading and downloading a substitute color group

Like named color groups, you can upload or download a substitute color group as an ICC

profile. The substitute color definitions are saved with private tags as part of an ICC profile,

allowing you to export the Substitution Group definitions between multiple print servers.
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COLORWISE PRINT OPTIONS

The ColorWise color management system provides print options that affect the output of
objects in various color spaces. By specifying the appropriate settings for each print option,
you can obtain the expected results for your jobs.

About this chapter

This chapter provides an overview of the ColorWise management system, which controls
color on the GA-1310 (see page 81), and detailed explanations of each print option. For the
location of each print option, see the following table.

ColorWise print option See

Auto Trapping page 82
Black Detection page 83
Black Overprint page 83
Black Text/Graphics page 84
CMYK Simulation Profile page 85
CMYK Simulation Method page 86
Combine Separations page 87
Composite Overprint page 87
Output Profile page 88
Print Gray using Black Only page 89
Rendering Styles page 90
RGB Separation page 91
RGB Source Profile page 91
Spot Color Matching page 93
Substitute Colors page 94

This chapter also provides information about PostScript printer drivers and instructions for
setting the ColorWise print options for Windows and Mac OS computers. For information
about printer drivers, see page 94.
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Managing color on the GA-1310

Applications allow you to generate color data for the GA-1310 in many different color spaces.
The most common type of color data produced from office applications is RGB, while
prepress applications generally produce CMYK data. Desktop applications also generate spot
colors, such as PANTONE colors. To complicate matters, a single page may contain a mix of
RGB, CMYK, and spot colors. The GA-1310 allows you to control the printing of mixed-
color documents with features that apply specifically to RGB, CMYK, or spot color data.

The following diagram illustrates the print options in the GA-1310 color management
process that affect color data conversions. You can access these print options when you send a
print job to the GA-1310. Choose the settings for your job based on the type of color data in
the job. For example, if your job contains only RGB color, choose the settings that affect RGB
data and disregard the other settings, since they do not apply. Most of these options and
settings are described in subsequent sections of this chapter.

RGB data ) RGB Source Profile
RGB Separation
Print Gray using Black Only
(RGB)

Rendering Style
Black Text/Graphics
Black Overprint
Output Profile
= GA-1310 = Color data sent
CMYK data —> CMYK Simulation Profile color processor to copier

CMYK Simulation Method
Print Gray using Black Only
(CMYK)

Black Text/Graphics

Black Overprint

Combine Separations
Output Profile

Spot color data |:|‘> Spot Color Matching

RGB Source Profile is the only color option that applies strictly to RGB color data. The other
options that affect RGB color also affect the more rarely used Lab, XYZ, and other calibrated
color spaces.

NoTe: With PostScript 3, a PostScript job can include calibrated CMYK (or
CIEBasedDEFG) data. The Rendering Style print option, which normally affects only RGB
data, affects calibrated CMYK data as well. The RGB Source Profile setting does not affect
calibrated CMYK data.
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ColorWise print options
To modify GA-1310 printing behavior, do any of the following:

*  Specify ColorWise options for an individual print job using the menus that appear in the
printer driver.

*  Specify most ColorWise options as server defaults from Color Setup in ColorWise Pro
Tools (see page 30). You can also set default values from GA-1310 Setup, as described in
Configuration and Setup. The defaults apply to all subsequent print jobs unless you
override them.

*  Specify ColorWise options, particularly default ICC profile settings and calibration
options, from ColorWise Pro Tools. These options include default Simulation Profile (see
page 85), Simulation Method (see page 86), default Source Profile (see page 91), RGB
Separation (see page 91), and associated calibration set (see page 34).

The following sections provide detailed explanations of the ColorWise print options and how
these options affect print jobs.

Auto Trapping

Trapping is a technique where the size of objects is modified so that colors printed next to
each other overlap slightly, to prevent white spaces between two colors. These white spaces, or
“halos,” can be caused by factors such as misregistration, the physical properties of the toners,

and the stiffness of the media. This illustration shows the same image with and without
trapping.

If you enable the Auto Trapping option, trapping is applied to all the objects in a job.

NoTEe: Auto Trapping is an optional feature for the GA-1310.



COLORWISE PRINT OPTIONS

Black Detection

The Black Detection option allows you to specify whether or not to detect black-and-white
pages before printing your job. To use this option, set Color Mode to Standard Color or
Expert Color.

o Off: Select Off if your job consists of black-only text pages combined with a significant
number of color pages.

* 0n: Select On if you are printing a predominantly black-and-white job. Black-and-white
only pages will print with the proper billing information.

Black Overprint

The Black Overprint option allows you to specify whether or not black text or black text and
graphics, defined as RGB=0, 0, 0, or as CMYK=0%, 0%, 0%, 100%, overprints colored
backgrounds.

* Text: Black text overprints colored backgrounds, eliminating white gaps and reducing the
halo effect or misregistration of colors. You can choose this setting only if the Black Text/
Graphics option is set to Pure Black On.

* Text & Graphics: Black text and graphics overprint colored backgrounds, eliminating
white gaps and reducing halo effects or misregistration of colors. You can choose this
setting only if the Black Text/Graphics option is set to Pure Black On.

* Off: Black text or text/graphics knocks out colored backgrounds.

NoTEe: Before sending the print job to the copier, PostScript applications may perform their

own black overprint conversions.

One example of how you might use this setting is a page that contains black text on a light
blue background. The background blue is CMYK=40%, 30%, 0%, 0%. The black text is
CMYK=0%, 0%, 0%, 100%.

*  With Black Overprint set to Text or Text & Graphics, the final text or text/graphic
portions of the page are overprinted, or combined with the underlying color. Black colors
generated by applications (for example, RGB=0, 0, 0 or CMYK=0%, 0%, 0%, 100%) are
printed using the black toner. This means that black text and line art does not exhibit
halftone artifacts (as long as the copier is calibrated correctly). No transition in cyan and
magenta toners occurs. The quality of the output is improved, because it does not show
artifacts near the edges of the text defined in the RGB color space (RGB=0, 0, 0).

*  With Black Overprint Off, the border of the text or text/graphics is on an edge that has
cyan and magenta toners on one side (outside the text) and black toner on the other side
(inside the text). This transition may cause visible artifacts due to the practical limitations
of the copier.

NoTE: Setting Black Overprint to Text/Graphics allows black text or graphics to overprint
color backgrounds (see “CMYK Simulation Method” on page 86).

NoTE: The reproduction of CMYK components is affected by the CMYK Simulation setting
and calibration curve when CMYK is not 0%, 0%, 0%, 0%.
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Black Text/Graphics

The Black Text/Graphics option affects black text and vector graphics. Under most
circumstances, set this option to Pure Black On. When Black Text/Graphics is set to Pure
Black On, black colors generated by applications (for example, RGB=0, 0, 0 or CMYK=0%,
0%, 0%, 100%) are printed using black toner only. The black text and line art do not exhibit
halftone artifacts (as long as the copier is calibrated correctly) and are not misregistered, since
one toner is used. In addition, this setting eliminates blasting. This option must be set to Pure
Black On if you want to set the Black Overprint option to Text or Text/Graphics.

For some jobs, it is preferable to set this option to Normal, for example, if the page includes
gradient fills that use black. The following table describes the behavior of the Black Text/
Graphics option with black data defined in different color spaces.

NoTe: Use the Black Text/Graphics option only when printing composites, not when printing

separations.

Color Black Text/Graphics = Normal Black Text/Graphics = Pure Black On or
Rich Black On
RGB=0,0,0 RGB=0,0,0 is printed according to the definition ~ RGB=0,0,0 is printed as K-only, using the black
for RGB=0,0,0 in the output profile. This may toner (Pure Black On) or 100% K plus 50%
(all other RGB values are . . . . .
be a rich black using all toners if the output Cyan (Rich Black On) using black and cyan
unaffected by the Black Text/ . .
. . profile specifies a rich black, or may be K-only toners. All other RGB values are unaffected by
Graphics setting)

if the output profile specifies K-only for
RGB=0,0,0. The output is affected by the

calibration curve.

the Black Text/Graphics setting.

CMYK=0%,0%,0%,100%

(all other CMYK values are
unaffected by the Black Text/

CMYK=0%,0%,0%,100% may be printed as
K-only or as a rich black using all toners,
depending on the CMYK Simulation Profile
setting.

CMYK=0%,0%,0%,100% is printed as K-only,
using the black toner (Pure Black On) or 100%
K plus 50% Cyan (Rich Black On) using black
and cyan toners, regardless of the CMYK

Graphics setting) . . . . Simulation Profile and CMYK Simulation
If CMYK Simulation Profile is set to a specific .
. Method settings. All other CMYK values are
profile, CMYK=09%,0%,0%,100% prints as unaffected by the Black Text/Graphics settin:
K-only and the amount of black toner is limited Y P &
by the simulation profile and the calibration Setting CMYK Simulation to ColorWise Off
curve. disables the simulation profile and the
alibrati . In thi , the black
Setting CMYK Simulation to ColorWise Off C ' rat}or} curve. n t 1.s can.: the black toner
. . . is not limited by the calibration curve.
disables the simulation profile and the
calibration curve. In this case, the black toner
is not limited by the calibration curve.
Spot Colors Standard spot color processing Standard spot color processing

(unaffected by the Black Text/
Graphics setting)




COLORWISE PRINT OPTIONS

NoTe: PostScript applications, such as QuarkXPress, may convert elements defined as
RGB=0, 0, 0 to four-color CMYK black before sending the job to the GA-1310. These
elements are not affected by the Black Text/Graphics option. For more information, see Fiery
Color Reference. Also, black text and line art defined as RGB=0, 0, 0 in office applications,
such as Microsoft Word, are converted to single-color black (CMYK=0%, 0%, 0%, 100%) by
the Microsoft PostScript 3 printer driver for Windows. To print this single-color black at the
maximum toner density of the copier, set Black Text/Graphics to Pure Black On.

CMYK Simulation Profile

The CMYK Simulation Profile print option allows you to print press proofs or simulations.
This setting specifies the offset press standard or other color printing device that you want to
simulate. This option affects CMYK data only.

Note: If a document contains an embedded CMYK profile, the embedded profile is applied
to CMYK data and the CMYK Simulation Profile option is ignored.

In the printer driver, you can view an unlimited number of custom Full simulations created
using ColorWise Pro Tools. The number of custom simulations is limited by the available

disk space on the GA-1310.

If you are printing with the PostScript driver and have Two-Way Communication enabled,
the name of each downloaded or custom profile appears in the CMYK Simulation Profile
menu. If Two-Way Communication is not enabled, downloaded or custom profiles appear as
Simulation-1 through Simulation-10. For more information about Two-Way
Communication, see the printer driver help.

The CMYK Simulation Profile setting you specify depends on the press standard for which
the CMYK data was separated.

* For images that were separated using a custom separation (such as a separation produced
with an ICC profile), choose the corresponding profile on the GA-1310 with the CMYK
Simulation Profile setting.

* For images that were separated for SWOP, choose SWOP as the CMYK Simulation Profile
setting.

To properly simulate a printed image that was separated using an ICC profile, the same profile
must be present on the GA-1310. For more information about downloading ICC profiles to
the GA-1310, see page 11.

Two settings are available if you want no CMYK simulation:

* The None setting sends your original CMYK data to the copier with calibration applied,
but without conversions to simulate another printer.

The None setting is recommended if you use another color management system instead of
ColorWise (for example, ColorSync or Photoshop). In this case, the GA-1310 is expecting
to receive CMYK data already in the device color space of the GA-1310. The GA-1310
will not convert the data, but it will apply calibration.
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* The ColorWise Off setting sends your original CMYK data to the copier without
calibration applied and without conversions to simulate another printer. The CMYK data
is still subject to maximum density constraints, however.

The ColorWise Off setting is not available in Color Setup and cannot be the default
CMYK Simulation Profile setting. You choose this setting for a specific job.

NoTe: When you print with the ColorWise Off setting, make sure the options you choose in
your application do not cause the application to modify CMYK data. If you enable PostScript
Color Management or include an embedded profile, the color data sent by the application is
similar to Lab color. When you print with settings like Let Printer Determine Colors or Let
Photoshop Determine Colors, the application either converts the CMYK data or tags it for
color management. You must specify No Color Management in the application when you
print with the ColorWise Off setting.

CMYK Simulation Method

The CMYK Simulation Method allows you to define your preferred CMYK-to-CMYK
conversion technique.

* Quick applies one-dimensional transfer curves to adjust output densities in the cyan,
magenta, yellow, and black channels. This technique leads to eye-pleasing color output
from your copier because pure primary colors are not “contaminated” by other colorants.
While it is the fastest simulation method and perfect for drafts, avoid using it for final
documents that are used as press proofs. Other techniques offer the color simulation
accuracy required by proofing applications.

* Full (Source GCR) provides a complete and accurate simulation based on colorimetric
transformations. Hues are preserved, even for primary colors. The Gray Component
Replacement (GCR) level that was specified in the original (source) document is also
preserved for K-only text and graphics. Processed black expressed in CMY is reproduced
using CMY toner. Full (Source GCR) is recommended for the highest quality press
proofing applications.

* Full (Output GCR) is a complete and accurate simulation method based on colorimetric
transformations. Hues are preserved, even for primary colors. With this method, the Gray
Component Replacement (GCR) level that was specified in the original document is not
preserved. Instead, all CMYK data is reseparated using the GCR level specified by the
output profile. This simulation technique is similar to traditional ICC color matching
methods and is more appropriate than Full (Source GCR) for full color printing designed
for the press, but reproduced on your copier.

NoTe: When you specify Pure Black On for Black Text/Graphics and Full (Output GCR) for
CMYK Simulation Method, the black text and graphics in your document are printed with
100% black-only toner.
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Combine Separations

The Combine Separations setting specifies how to print separated CMYK data. It supports:
Cyan, Magenta, Yellow, Black.

* Off prints each separation individually.

*  0n combines separations as a single, composite-color document, and automatically makes
the settings for the following print options: Color Mode (CMYK), Black Text/Graphics
(Normal), Black Overprint (Off), and Spot Color Matching (Off).

The results of combining the multiple plates are predictable and accurate, regardless of the
original application used. This feature also fully supports DCS 2.0 file formats when included
in a PostScript print job from a page layout application.

The following applications have been tested with Mac OS and Windows for compatibility
with the Combine Separations option:

* Adobe Hlustrator
* Adobe InDesign

* Adobe PageMaker
¢ Adobe FreeHand
¢ QuarkXPress

For information about using the Combine Separations option with applications such as
Photoshop, see Fiery Color Reference.

Composite Overprint

When overlapping objects are printed, the foreground object can either overprint or knock
out the background object. With overprinting, the color of the background object shows
through the foreground object where they overlap, and the resulting color is a combination of
the colors of the two objects. With a knock-out, the foreground object hides the background
object where they overlap.

The Composite Overprint print option allows you to print overprinted objects as specified in
the source file. By default, the Composite Overprint print option is off and overlapping
objects print as knockouts.

NoTe: The Composite Overprint option does not overprint the foreground object if it is an

RGB object.
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The Composite Overprint print option is supported for PostScript and PDF jobs produced
by the following applications:

¢ Adobe Acrobat

¢ Adobe Illustrator
* Adobe InDesign
* Adobe FreeHand
¢ QuarkXPress

¢ Corel DRAW

If Composite Overprint is enabled for a job that contains spot colors, Spot-On must be

enabled on the GA-1310.

A job with more than 32 spot colors may not print as expected.

Output Profile

Because the output profile is applied to all data in the print job, make sure the profile you
select is the right one for your job. The default output profile consists of a profile for your
copier that describes its color characteristics and a calibration target that describes the
expected behavior of the copier.

Default profiles are provided for Plain Paper, Thickl Paper, Speciall Paper, and Special2
Paper. To obtain more accurate color for other paper types, you can create custom profiles for
those papers and import them to the GA-1310, associating them with the appropriate
calibration sets (Thick2 Paper for a Thick2 paper type, for example). This is the only way to
use the calibration sets that are not already associated with default output profiles.

Use the ColorWise Pro Tools Profile Manager to download your own output profiles to the
GA-1310 (see “Using Profile Manager” on page 24). Downloaded output profiles are at first
associated with the calibration target that is tied to the default output profile. You can edit
calibration target D-Max values separately.

If you are printing with the PostScript driver and have enabled Two-Way Communication,
the name of each downloaded or custom profile appears in the Output Profile menu. If Two-
Way Communication is not enabled, downloaded or custom profiles appear as Output-1
through Output-10 and the Use Server’s Default setting appears as a selection. Select the Use
Server’s Default setting to use the default Output Profile set in Color Setup. For more
information about Color Setup, see “Using Color Setup” on page 30. For more information
about Two-Way Communication, see the printer driver help.

Select the Use Media Defined Profile setting to automatically apply the output profile
associated with the media type used in a print job rather than setting a specific output profile.
For more information, see “Using media-defined output profiles” on page 25.
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Print Gray using Black Only

When Print Gray using Black Only (RGB) is enabled, any RGB color where R=G=B is
printed using only black toner instead of processed black. Similarly, when Print Gray using
Black Only (CMYK) is enabled, any CMYK color where C=M=Y=0 and K=any value is
printed using only black toner instead of processed black.

You can choose to apply the Print Gray using Black Only option to either Text and Graphics
or to Text, Graphics, and Images.

The following limitations apply:

The Print Gray using Black Only option has no effect on a job that is pre-separated, except
that if Print Gray using Black Only (CMYK) is off, each separation, which is a grayscale
image, is printed in a 4-color gray.

If CMYK Simulation Method is set to Full (Source GCR) or Quick, the Print Gray using
Black Only (CMYK) setting does not affect the output.

If RGB Separation is set to Simulation, the Print Gray using Black Only (RGB) option is
disabled. Likewise, if the Print Gray using Black Only (RGB) option is enabled, you
cannot set RGB Separation to Simulation.

If Black Text/Graphics is set to Pure Black On or Rich Black On, it takes precedence over
Print Gray using Black Only for 100% black text and graphics.

If a gray is specified as a spot color, the Print Gray using Black Only option does not affect
that gray.
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Rendering Styles

The Rendering Style option specifies a CRD for color conversions. To control the appearance

of images, such as prints from office applications or RGB photographs from Photoshop, select
the appropriate rendering style. The GA-1310 allows you to choose from the four rendering
styles currently found in industry standard ICC profiles.

GA-1310
rendering style

Best used for

Equivalent ICC
rendering style

Photographic: Typically results

in less saturated output than
presentation rendering when
printing out-of-gamut colors. This
style preserves tonal relationships in

Photographs, including scans and
images from stock photography
CD:s and digital camera images.

Image, Contrast,
and Perceptual

images.

Presentation: Creates saturated Artwork and graphs in Saturation,

colors but does not match printed presentations. In many cases, this Graphics

colors precisely to displayed colors. style can be used for mixed pages

In-gamut colors, such as flesh that contain presentation graphics

tones, are rendered well. This styleis  and photographs.

similar to the Photographic

rendering style.

Relative Colorimetric: Provides Advanced use when color matching  Relative

white-point transformation between is important, but you prefer white Colorimetric

the source and destination white colors in the document to print

points. For example, the bluish as paper white. This style may

white color (gray) of a monitor is also be used with PostScript color

replaced by paper white. This style management to affecc CMYK

avoids visible borders between data for simulation purposes.

blank spaces and white objects.

Absolute Colorimetric: Provides Situations when exact colors are Absolute
needed and visible borders are not Colorimetric

no white point transformation
between the source and destination
white points. For example, the bluish
white color (gray) is not replaced

by paper white.

distracting. This style may also be
used with PostScript color
management to affecc CMYK
data for simulation purposes.
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RGB Separation

The RGB Separation option determines how RGB colors (as well as Lab and XYZ colors) are
converted to CMYK. The name of this option is meant to be descriptive, because the option
defines the color spaces that are used by the GA-1310 to “separate” the RGB data into CMYK

values.

The two choices available for this option determine whether RGB data is converted into the
full gamut of the copier (output) or is first converted into the gamut of another digital printer
or press standard (simulation). This feature helps make one device behave like another for
RGB data. For example, if a high-quality ICC profile is available for another print device, the

copier can simulate the behavior of that device.

RGB Separation is also useful for prepress applications. For example, it allows you to
experiment with the appearance of an RGB scan under different press printing conditions,
without having to convert the RGB data to CMYK data for each condition. When the desired
printing condition is found, convert the file to CMYK, using the same CMYK simulation
profile that you used during the experimentation.

NoTe: Use the RGB Separation print option in conjunction with the Output Profile or
CMYK Simulation Profile print options.

e Output converts all RGB colors into the CMYK color space of your copier (when set to the
printer’s default), or a customized CMYK color space for your copier (when set to
Output 1-10).

* Simulation converts all RGB colors into the CMYK color space for a specified simulation
(select the desired simulation with the CMYK Simulation Profile print option).

RGB Source Profile

The RGB source profile setting allows you to define the characteristics of the RGB data in
your document so that the appropriate color conversion occurs on the GA-1310. Commonly
used monitor color spaces are available from the printer driver and the GA-1310. For others,
use ColorWise Pro Tools Profile Manager to download custom monitor or scanner profiles.

When you specify a setting other than None for the RGB Source Profile, the GA-1310
overrides source color space definitions or profiles that other color management systems may
have specified. For example, if your document contains an embedded RGB profile, the RGB
Source Profile setting overrides it. In cases where you do 7oz want this setting to override
another specified source color space, choose None.
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When you specify a setting other than None, because the color space definitions are
overridden, the output from the GA-1310 is consistent across platforms. The GA-1310 RGB
Source Profile options are as follows:

* EFIRGB specifies an EFI-defined color space recommended for users who have no detailed
information about their RGB data.

* SRGB (PC) specifies the definition of a Windows computer monitor profile used as the
default.

* Apple Standard specifies the definition of a Mac OS computer monitor profile used as the
default.

* Adobe RGB (1998) is an Adobe-defined color space, used in pre-press as the default
working space in Photoshop 5.

* ECI-RGB is the European Color Initiative (ECI) recommended space for use as an RGB
working color space and color data exchange format for ad agencies, publishers,
reproduction and printing houses.

* Fiery RGB is an EFI-defined color space recommended for users of office applications. This
color space is similar to EFIRGB but is larger and can provide a more desirable blue
output.

* Sources 1-10 specify the definitions you download as RGB source profiles.

If you are printing with the PostScript driver and have enabled Two-Way
Communication, the name of each downloaded profile appears in the RGB Source Profile
setting menu. If Two-Way Communication is not enabled, downloaded profiles appear as
Source-1 through Source-10. For more information about Two-Way Communication, see
the printer driver help.

* None instructs the GA-1310 to allow the RGB sources you defined elsewhere, such as in
the application, to be used. When you set RGB Source to None, the appearance of colors
is not independent of the file type. For example, RGB EPS files looks different from RGB
TIFF files.

With RGB Source set to None, PostScript RGB data that contains a source color space
definition is converted using the CRD specified by the Rendering Style option (see
“Rendering Styles” on page 90). Non-PostScript RGB data and PostScript RGB data that
does not contain a source color space definition are converted using a general undercolor
removal (UCR) conversion method.
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Spot Color Matching

The Spot Color Matching option provides automatic matching of spot colors with their best
CMYK equivalents.

e 0n: The GA-1310 uses a built-in table to generate the closest CMYK matches of spot
colors your copier can produce. (New tables are generated when you add new output

profiles.)

With Spot-On, the GA-1310 uses the CMYK matches determined through Spot-On (see
page 50).

* 0ff: The GA-1310 processes the spot color as CMYK data and uses CMYK equivalents
defined by the spot color manufacturer, such as PANTONE. These are the same CMYK
equivalents used by applications that include spot color libraries.

NoTEe: Spot colors that are not included in the built-in table are treated as CMYK.

For jobs that include spot colors, set Spot Color Matching to On unless you are printing press
simulations. In that case, set Spot Color Matching to Off and choose the appropriate CMYK
Simulation setting (see page 85).

For a PDF job that includes spot colors that are not included in the built-in table, setting Spot
Color Matching to On retains the original spot colors. The GA-1310 references the built-in
table to generate the closest CMYK matches of the original spot color.

NoTe: Use Spot Color Matching only when printing composites, not when printing
separations.

Spot Color Matching and the PANTONE Coated Color Reference

The PANTONE Coated Color Reference prints differently depending on the Spot Color
Matching setting (see Fiery Color Reference).

* 0On: The GA-1310 uses a built-in table or, with Spot-On, the Spot-On color dictionaries to
generate the best matches for the PANTONE colors that your copier can produce.
The PANTONE number is displayed below each swatch.

For more information about Spot-On, see page 56.

* 0ff: The GA-1310 prints swatches using the CMYK values recommended by Pantone,
Inc. (and used by applications that provide PANTONE color libraries). The CMYK values
used to generate the color, as well as the PANTONE number of the color, are printed
below each swatch. These CMYK values are printed through the selected CMYK
Simulation and Output Profile settings.
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Substitute Colors

Spot-On allows you to create a list of substitute colors. These are colors that, when called for
in a document by their RGB or CMYK values, are substituted with a different color having
the CMYK values from the Spot-On color dictionary. This permits exact color control and
overrides individual RGB and CMYK colors.

To enable substitute colors for a job, select the Substitute Colors option.

For more information about creating and using substitute colors, see “Spot-On with
Substitute Colors” on page 70.
g

Printer drivers and print options

The printer driver writes a PostScript file containing the instructions generated by your
application and the settings for the ColorWise print options you selected. The printer driver
then sends the PostScript file to the GA-1310. The GA-1310 performs PostScript processing
and color conversions and sends raster color data to the copier.

Setting print options for Windows

This section explains how to set color management print options with the Adobe and
Microsoft PostScript printer drivers for Windows, PostScript 3 printer drivers that take full
advantage of the color features of the GA-1310.

Before you proceed, do the following:
* Install the printer driver and the GA-1310 PPD (see Printing from Windows).
* Set up the GA-1310 for printing (see Printing from Windows).

NoTe: The following illustrations and instructions do not apply to all applications. Many
applications, such as Adobe PageMaker, Photoshop, Adobe Illustrator, QuarkXPress, and
Corel DRAW, have other color management options in addition to those presented in the
printer driver. For information about specific applications, see Fiery Color Reference.

Use the following procedure to set the color options for Windows computers.

To SET PRINT OPTIONS FOR WINDOWS COMPUTERS

1 Choose Print in your application.
2 Select GA-1310 as your printer and click Properties.

In the Properties dialog box, the Fiery Printing tab is displayed.
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3 Click the Color icon.

&% Aero Document Properties x|

Fiay Printing | PostSerpt | about |

fest——— [ B b B|eBR B a3 & 8 Ed
Detault Job Templafs Basic Joblnfo Media Lapout | Color | Image  Finishing %DP Stamping  Printer :
b ~ Print Mode
@ % Standard Color
@ " Expert Color Expert Settings ... |
" Grayscale
. 5
Printer Status: V¥ Elack Detection B‘ [~ Composite Dverprint
Online D@
Idl
° @ ™ Substitute Colors B [ Combine Separations

E [~ Auto Trapping
efi

aK I Cancel I Apply Help

4 Specify the settings for the print options in the Color window.
For information about ColorWise print options, see page 82.
5 Click Expert Settings.

The Expert Color Settings dialog box appears.

2=
RGEB Source Profile Rendering Style
= ®, | = [ ~ | —reseriaton | —
o Print gray using black only (RGB) ﬂ
0 - RGE Separation
I J " Simulation " [utput
p— ]
= |_|_> CHMYK Simulation Profile CMYK Simulation Method
% ﬁ sy | 150 Coated 'l Full [Output GCR] v | — Output Profile
Print Gray using Black Only [CHYK] &+ Use Media Defined Profile
Test/Graphics/mage 'I " Use Dutput Prafile
— | <profile name= VI
Ed
=
=3 =} [v Spot Color Matching
Black Text/Graphics
E s | Pure Black On 'l
@
Black Dverprint

Test/Graphics v | —

Diefaults Update | QK I Cancel |

This dialog box displays most of the ColorWise print options for the GA-1310.
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Click Update to display the current GA-1310 settings.

If the Update button does not appear, make sure that Two-Way Communication is set up.
For information about enabling Two-Way Communication, see the printer driver help.

Specify the settings for the main ColorWise print options.

For most users, the default settings provide adequate color control. For information about
individual print options, see page 82.

Click OK to exit Expert Color Settings.

Click OK to close the Properties window, and then click OK to send your job.
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Setting color management print options for Mac 0S

This section explains how to set color management print options with the printer drivers for

Mac OS.

Before you proceed, do the following:

* Install the GA-1310 PPD (see Printing from Mac OS).

* Set up the GA-1310 for printing (see Printing from Mac OS).

To SET PRINT OPTIONS FOR MAC OS X COMPUTERS

1 Choose Print in your application.

The Print dialog box appears.

Printer: | AERO_Print )
Presets: | Standard )
Copies & Pages |+]
Copies: 1— ™ collated
Pages: @ al|
O From: 1 to: |1

@ (Preview) CSave As PDF ) C Fax... ) C Cancel ) (—FHH

2 Mac 0S X v10.5 only: Expand the dialog box, if necessary, by clicking the arrow next to the
Printer name.

3 Mac 0S X v10.3.9 and 10.4.x: Click Copiers & Pages, choose ColorSync from the drop-down
list, and choose In Printer from the Color Conversion list.

Printer: | AERO_Print |+]
Presets: | Standard |+J
ColorSync |+]
Color Conversion: @
Quartz Filter:  None %

® (Preview) (Save As FDF...) ( Fax... ) (Cancel) (—hnt—)
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Mac 0S X v10.5: Click Preview, choose Color Matching from the drop-down list, and select In
Printer.

Printer: [ AERO_Print I-G-‘ B

Presats: | Standard H

Copies: # Collated

Pages: eAII
OFrom: 1 to: |1

Paper Size: | US Letter B‘ 8.50 by 11.00 inches

Orientation: @ I

[Color Matching I-‘—‘

Scale: | 100 %

(O ColorSync @ In Printer

Gar) 1ot ()

® (r) G )

4 Choose ColorWise from the drop-down list.

The Color pane appears.

Printer: | AERO_Print

Presets: | Standard

[ Colorwise

Print Mode

@ Standard Color

() Expert Color Expert Settings...

() Grayscale

Eﬂlack Detection

[_] Composite Overprint
] Substitute Colors

[l Combine Separations

(] Auto Trapping

] Two Way Communication

Printer Address:
( PDF v ) (Preview) (Supplies,, ) (Standard) ( Cancel ) : ;

5 Select Two-Way Communication.
For information about enabling Two Way Communication, see the printer driver help.
6 Specify the settings for the print options in the Color pane.

For information about ColorWise print options, see page 82.
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Click Expert Settings.

The Expert Color Settings window appears.

Expert Color Settings

REE RGE Source Profile: Rendering Style

===} | Fiery RGB v5 |+]_’ Presentation Iﬂj
L)

RGE Separation
Print Gray using Black Only (RGB)
=

Off 5-

) simulation @ Output

CMYK

CMYK Simulation Profile CMYK Simulation Method: - Output Profile:

- ===} 150 Coated [%) = Full Output GCR)  [§) sy CElseserve g Hefault

A @ Use Media Defined Profile
) use Output Profile
=

p | <profile name> v

Print Gray using Black Only (CMYK):

spOT Text/Graphics/I... BC

ey [ Spot Color Matching

Black Text/Graphics

wes| Pure Black On B:

Black Overprint: |
Text/Graphics B:
o)

Choose settings for the main ColorWise print options.

For information about ColorWise print options, see page 82.
Click OK.

The Color pane reappears.

Click Print.

Using Expert Color Settings to enable Device Link Profiles

When you print a job, you can enable Device Link Profiles by using the GA-1310 printer
driver if you have Two-Way Communication enabled. When you enable a Device Link
Profile, you will be able to see the Device Link Profile in use in Expert Color.

NoTe: If you do not have Two-Way Communication enabled, and you select an RGB Source
Profile and Output Profile that corresponds to a Device Link Profile, the Device Link Profile
will be activated, although you will not see the Device Link Profile in use in Expert Color.

For information about installing and assigning Device Link Profiles, see page 25.

NoTe: The procedures for enabling Device Link Profiles using Expert Color Settings for
Windows and Mac OS X are similar. The following illustrations use Windows screens. Any
differences are noted.
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To USE THE GA-1310 PRINTER DRIVER TO ENABLE DEVICE LINK PROFILES
1 Enable Two-Way Communication.
For more information about enabling Two-Way Communication, see the printer driver help.
2 From your application, select Print.
3 Select GA-1310 as your printer and click Properties.
4 Click the Color icon.
5 Click Expert Settings.
6 Select the Source Profile and the Output Profile.

When you select a Source Profile and Output Profile combination that is defined in a Device
Link Profile, the Device Link Profile is automatically enabled.

When the Device Link Profile is selected, the Color Process workflow updates and some
options may not appear. You will see the message “Device Link Profile in use” under the RGB
Source Profile or CMYK Simulation Profile.

1 Device Link Profile in use 21

REGB Source Profile

fra} @, |== |idobe RGE[1998] *
T} b
= @ o i Frafie il =tmiee ik Ereiie eres
o CHYK Simulation Profile CHMYK Simulation Method
E ﬁ sy |50 Coated ‘I Full [Output GCR) v | — Output Profile
Print gray using Black Only [CMYK) £~ Use Media Defined Prafile
Text/Graphics/Image 'l £+ Use Dutput Profile
— —>| =profile nam es vl
Ed
s
& wmmmp [ Spot Color Matching
Black Text/Graphics
E | Pure Black On 'I
= =
el Black Dverprint
Text/Graphics v | —
Defaults Update | oK I Cancel

7 Click OK to exit Expert Color Settings.

8 Click OK to close the Properties window, and then click OK to send your job.
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IMPORTING DENSITY MEASUREMENTS

This chapter describes Simple ASCII File Format (SAIFF), which you can use to import
density measurements from measurement devices into ColorWise Pro Tools Calibrator. To
use your own measurement data from an alternate measurement instrument, rather than
make measurements directly in Calibrator, record your individual readings in a text file,
structured as described in this chapter. You can then import the data into Calibrator by
clicking From File under Get Measurements in the Calibrator main window.

Simple ASCII Import File Format

This format describes Status T measurement data for import into the ColorWise Pro Tools
Calibrator. The three possible file formats are:

* 1D Status T density for EFI 21 patch page
* 1D Status T density for EFI 34 patch page
* 1D Status T density for other pages (maximum of 256 patches per ink)

The file format is ASCII and has no tabs. A single space or multiple spaces are used

as delimiters. Blank lines are not allowed. Each line in the file represents four patches

(C, M, Y, K) of a specific ink value. Comments may be on any line in the file. Comment lines
must start with a pound sign (#) followed by a space. (A line with a pound sign followed by
any character other than a space has been reserved.) Comments must be on a line by
themselves.

Each line of data contains five values. The first number is the sequential patch number (for
EFI 21 and EFI 34 pages) or the ink value percentage (for other pages). The four values that
follow are the density values of C, M, Y, and K of the corresponding patch. Lines are ordered
either by increasing sequential patch numbers, or by increasing the ink percentage.

For Windows computers, the file extension must be .cm0 or cm1. For Mac OS computers,

the file type must be “TEXT".

Measurement data in EFI 21 and EFI 34 are paper-relative. For other pages, if the first line
corresponds to zero ink value, the Calibrator assumes that the measurement data is absolute
and adjusts it to become paper-relative by subtracting the density values of the first line from
the remaining patches.



IMPORTING DENSITY MEASUREMENTS

Example of 1D Status T density for EFI 21 patch page

This file format is used to specify the Status T density measurements of the EFI 21 patch
page. The value in the first column is the patch number. The first patch must be 1 and the last
must be 21.

#1EFI 3

# EFI ColorWise 2.0 Data

type: 1DST21

# Cyan Magent Yellow Black

1 0.0300 0.0400 0.0200 0.0400
2 0.0600 0.0700 0.0800 0.0700
3 0.1000 0.1000 0.1000 0.1000
(...more data...)

20 1.6700 1.3400 0.8900 1.6700
21 1.7200 1.4300 0.9300 1.7500

Example of 1D Status T density for EFI 34 patch page

This file format is used to specify the Status T density measurements of the EFI 34 patch
page. The value in the first column is the patch number. The first patch must be 1 and the last
must be 34.

#1EFI 3

# EFI ColorWise 2.0 Data

type: 1DST34

# Cyan Magent Yellow Black

1 0.0300 0.0400 0.0200 0.0400
2 0.0600 0.0700 0.0800 0.0700
3 0.1000 0.1000 0.1000 0.1000
(...more data...)

33 1.6700 1.3400 0.8900 1.6700
34 1.7200 1.4300 0.9300 1.7500
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Example of 1D Status T density for an arbitrary page

This file format is used to specify the Status T density measurements of a user-defined patch
page. The value in the first column is the ink/toner percentage of the patch. The first

percentage must be 0 and the last percentage must be 100. The percentages must increase in
between.

#I1EFI 3

# EFI ColorWise 2.0 Data

type: 1DST

# percnt Cyan Magent Yellow Black
0.0000 0.0300 0.0400 0.0200 0.0400
0.3922 0.0600 0.0700 0.0800 0.0700
1.1765 0.1000 0.1000 0.1000 0.1000
(...more data...)

98.0000 1.6700 1.3400 0.8900 1.6700
100.0000 1.7200 1.4300 0.9300 1.7500
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